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CHAPTER 1

Introduction

1.1 OVERVIEW

RSL10 is a multi-protocol, Bluetooth® 5 certified, radio System on Chip (SoC), with the lowest power
consumption in the industry. It is designed to be used in devices that require high performance and advanced wireless
features, with minimal system size and maximized battery life. The RSL10 Software Development Kit (SDK) includes
firmware, software, example projects, documentation, and development tools. The Eclipse-based ON Semiconductor
Integrated Development Environment (IDE) is offered as a free download with optional support for Arm® Keil®
uVision® and TAR Embedded Workbench®.

Software components, device and board support information are delivered using the CMSIS-Pack standard.
Standard CMSIS-Drivers for peripheral interfaces and FreeRTOS sample applications are supported. With the
CMSIS-Pack standard, you can easily go beyond what is included in our software package and have access to a variety
of generic Cortex-M software components. If you have existing RSL10 projects and have not used the RSL10
CMSIS-Pack before, see Appendix A, “Migrating to CMSIS-Pack” on page 48 for more information.

The RSL10 SDK allows for rapid development of ultra-low power Bluetooth Low Energy applications. Convenient
abstraction decouples user application code from system code, allowing for simple modular code design. Features such
as FOTA (Firmware Over-the-Air) can easily be added to any application. Advanced debugging features such as
support for SEGGER® RTT help developers monitor and debug code. Sample applications, from Blinky to
ble peripheral server bond and everything in between, help get software development moving quickly. An optional
Bluetooth mesh networking CMSIS-Pack quickly enables mesh networking for any application.

This document helps you to get started with the RSL10 SDK. It guides you through the process of connecting your
RSL10 Evaluation and Development Board, installing an IDE and the CMSIS-Pack, configuring your environment, and
building and debugging your first RSL10 application.

NOTE: RSLI10 contains a low power DSP processor core; see RSL10 LPDSP32 Software Package.zip for
more information.

1.2 INTENDED AUDIENCE

This manual is for people who intend to develop applications for RSL10. It assumes that you are familiar with
software development activities.

1.3 CONVENTIONS

The following conventions are used in this manual to signify particular types of information:

monospace Commands and their options, file and path names, error messages, code samples and code
snippets.
mono bold A placeholder for the specified information. For example, replace £ilename with the actual

name of the file.
bold Graphical user interface labels, such as those for menus, menu items and buttons.

italics File names and path names, or any portion of them.
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CHAPTER 2

Setting Up the Hardware and Software

2.1 Prerequisite Hardware

The following items are needed before you can make connections:

*  RSL10 Evaluation and Development Board and a micro USB cable
* A computer running Windows

2.2 CONNECTING THE HARDWARE
To connect the Evaluation and Development Board to a computer:
1. Check the jumper positions:
Ensure that the jumper CURRENT is connected and POWER OPTIONS is selected for USB. Also, connect the

jumpers TMS, TCK and SWD. Finally, connect the headers P7, P8, P9 and P10 to 3.3 V, as highlighted in
Figure 1.

= 5 H 0 pag ™2
e 5 n,,.=n3§c-3
' Hragaes

FA2RS0 " s

JTAG MCU

Figure 1. Evaluation and Development Board with Pins and Jumpers for Connection Highlighted

2. Once the jumpers are in the right positions, you can plug the micro USB cable into the socket on the board.
The LED close to the USB connector flashes green during the first time plugging in, then turns a steady green
once the process is finished.
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Getting Started with RSL10

2.2.1 Preloaded Sample

The Evaluation and Development Boards come with one of the following preloaded sample applications:

e “Peripheral Device with Sleep Mode” is on boards with a serial number lower than 1741xxxxx.
e “Peripheral Device with Server” is on boards with a serial number higher than 1741xxxxx.

For more information about sample applications, refer to the RSL10 Sample Code User’s Guide.

2.3 PREREQUISITE SOFTWARE

Install the latest version of J-Link. It is available from the SEGGER website. Make sure to run the J-Link DLL
updater, as shown in Figure 2, to update the J-Link DLL inside your IDE and confirm that the version used by the IDE

has been updated.

[l SEGGER J-Link DLL Updater V6.34h [E3 ]

2 applications found that can be updated to %6.34h of the J-Link software:

SEGGER Embedded Studio ARM 3.20 (x86) (DLL %6.40 in "C:\Program Files (x86),SEGGER\SEGGER Embedded Studio
Keil MDE-ARM (DLL %6.40 in "C:\Keil_v5YARM\ Segger)

Select All SelectMane

Selectthe ones you would like to replace by this version.
The previous wersion will be renamed and keptin the same folder, allowing manual
"undo".

S P U PN (Pt Y

Ok Cancel

Figure 2. J-Link DLL Updater
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CHAPTER 3

Getting Started with the Eclipse-Based ON
Semiconductor IDE

3.1 ON SEMICONDUCTOR IDE AND RSL10 CMSIS-PACK INSTALLATION PROCEDURES

If you have a previous version of the ON Semiconductor IDE (formerly known as the RSL10 Software
Development Kit (SDK)) installed:

1. Uninstall RSL10 Development Tools using Windows Control Panel.
2. Check if the RSL10 SDK folder is still there; if it is, delete it.

Install your new ON Semiconductor IDE by running ON_Semiconductor_IDE.msi. The ON Semiconductor IDE is
installed in this location by default: C:\Program Files (x86)\ON Semiconductor\IDE.

The release version and build number are stored in the REVISION text file at the root of the installed
ON Semiconductor IDE.

To install the RSL10 CMSIS-Pack:

1. Download the RSL10 CMSIS-Pack from www.onsemi.com/RSL10 and save it in any temporary folder.

2. Open the ON Semiconductor IDE and choose the desired location for your new workspace — for example,
c:\workspace — and click OK.

3. On the top right corner, click on the Open Perspective icon, select CMSIS Pack Manager, and click OK (see
Figure 3).

& Open Perspective =X

TEC/C++ (default) .
\E\@ 881CMSIS Pack Manager
[EaCVS Repository Exploring
G 15 Debug

Quick Access ;| [£5]| (i@ #5GDB Trace
[ Git
Open Perspective i B TTng Kernel
- [0S Tracing Overview
= %y Packs
ailable. 1) Planning
EHRemote System Explorer

[y Resource
&Y Team Synchronizing

= .

Open ] l Cancel

Figure 3. Opening the CMSIS Pack Manager Perspective

4. Click on the Import existing packs icon, select your pack file ONSemiconductor.RSL10.version.pack,
where version is a number such as 2.3.27, and click Open (see Figure 4).

www.onsemi.com
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- - — n q
£ Import Packs ﬁ
@Ov‘ | » Computer » SYSTEM (C:) » cmsis_packs » v‘&, H Search ¢ p'
Organize ¥ New folder 1 Q
e ] M Deskiop * [ Name Date modified
¢ Downloads F
I .Download 3/2/2018 10:12 Al
«» Recent Places .
3 Quick Access :| £ | B[ 4= | Web 3/2/2018 9:56 AM
= - - 5
[ = = o 5 | | ONSemiconductor 3/2/2018 10:12 Al
1 packs | @| &3¢ T T O = PackProperties g o Libraries . . —
— e e |[¥] % ONSemiconductor.RSL10.1.2.0.pack 8/29/2017 3:52 Ph
Import existing packs BEE® T ‘.. Documents — e
4. Music b
& Pictures
; Videos
& Computer
& SYSTEM (C) k=T 1 | b
File name: ONSemiconductorRSL10.1.2.0.pack - |PackFiIes (*.pack) "
[ Open }V] \ Cancel I

Figure 4. Installing the RSL10 CMSIS-Pack

5. The IDE prompts you to read and accept our license agreement, and then installs the RSL10 CMSIS-Pack in
the specified pack root folder.

6. The RSL10 CMSIS-Pack now appears in the list of installed packs. In the Devices tab, if you expand All
Devices > ONSemiconductor > RSL10 Series you can see RSL10 listed there. You can manage your
installed packs in the Packs tab. Expanding ONSemiconductor.RSL10 makes the Pack Properties tab display
the details of the RSL10 CMSIS-Pack. Figure 5 on page 9 illustrates what the Pack Manager perspective looks

like after installation.
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ON Semiconductor

© Onygen2001 - cmsis/source/start.c - Eclipse
File Edit Source Refactor Mavigate Search Project Run Window Help

s v IdE & @ Q L HLL - R v il = X o

N Devices 11 & FE@ (% Y5O0 @@packs ™ EFE®@| @ P T 0 = packProperties H 2O
Search Pack ter text
Device Summary Pack
U AN Devices 1 Device

Action Description 4 B ONSemiconductor RSL10L20
4 * Dewice Specific 1 Pack RSL10 selected B Boards
+ ¥ Onsemiconductor 1 Device + % ONSemiconductorRSL10 @ U tadal ON Semiconductor RSL10 Device F « @ Components
« " RSL10 Series 1 Device #1120 # Remove | Release 120 4 @ Device
B RsLio ARM Cortes-M3 48 MHz, 32 kB RAM, 384 kB * Previous ONSemiconductor RSL10 - Previow + @ Libraries
* Generic Software Packs with generic conter # Calibrate
@ Custom Protocol
@ Flash
@ System
@ Math
@ Kemel
@ BLE
@ Remote_Mic
@ Weak_PRF
¥ Starup
@ Bluetooth Profiles
+ B Devices
4 4§ RSL10 Series
B RSLI0
4 % Examples
ADC_UART (RSL1D Evaluation Board)
Aes128 (RSL10 Evaluation Board)
Blinky (RSL10 Evaluation Board)

Central_client (RSLLO Evaluation Board)  ~
v (= in »

B Console &
CMSIS Pack Manager
109:12:38: Importing Pack ONSemiconductor . R5L18.1.2.8 completed

* B

Figure 5. Pack Manager Perspective after RSL10 CMSIS-Pack is Installed

3.2 BUILDING YOUR FIRST SAMPLE APPLICATION WITH THE ON SEMICONDUCTOR IDE

This section guides you through importing and building your first sample application, named blinky. This
application makes the LED (DIO6) blink on the Evaluation and Development Board.

For more information about the sample applications, see the RSL10 Sample Code User’s Guide.

3.2.1 Launching the ON Semiconductor IDE
To use the IDE for the first time, follow the steps below:
1. To start the IDE, go to the Windows Start menu, and select ON Semiconductor > ON Semiconductor IDE.

2. When you open the IDE for the first time, you are prompted to select a workspace for the session. The
workspace is the work area for all your IDE projects.

IMPORTANT: Create a new workspace for your version of the ON Semiconductor IDE. Re-using an existing
workspace originally created with another Eclipse-based IDE might not be compatible.

3.2.2 Importing the Sample Code

Import the sample code as follows:

1. Inthe Pack Manager perspective, click on the Examples tab to list all the example projects included in the
RSL10 CMSIS-Pack.

2. Choose the example project called blinky, and click the Copy button to import it into your workspace (see
Figure 6 on page 10).
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&8 Packs [ Examples & O Only show examples from installed packs ‘ @ ‘ &= Y70

Search Example

Example Action Description
blinky (RSL10 Evaluation Board) & Copy . Blinky GPIO I/O Sample Code
central_client (RSL10 Evaluation Board) % Copy Central Device with Client Sample Code
central_client_double (RSL10 Evaluation B #* Copy Central Device with Client Sample Code - Double
central_peripheral (RSL10 Evaluation Boar ¥ Copy Central Peripheral Device Sample Code
custom_protacol_trx (RSL10 Evaluation B Copy Low Latency Audio Sample Application with Custom Prot...
default_ MANU_INFO_INIT (RSL10 Evaluati|% Copy Default System Initialization Function
hei_app (RSL10 Evaluation Board) % Copy Host Controller Interface Application
pair_bond (RSL10 Evaluation Board) % Copy Pairing and Bonding with Peripheral Device Sample Code
pair_bond_master (RSL10 Evaluation Boar® Copy Pairing and Bonding with Central Device Sample Code
peripheral_server (RSL10 Evaluation Boarc % Copy Peripheral Device with Server Sample Code
peripheral_server FOTA (RSL10 Evaluatior® Copy Peripheral Device with Server for Sending Firmware Over ...
peripheral_server_hrp (RSL10 Evaluation B¥ Copy Heart Rate Peripheral Device with Server Sample Code
peripheral_server_sleep (RSL10 Evaluation® Copy Sleep Mode Sample Code for Peripheral Device with Serv...

sleep_ble_advertisements (RSL10 Evaluati|% Copy Sleep and Wakeup with Bluetooth Low Energy Technolog...
sleep_RAM _retention (RSL10 Evaluation B/ Copy Sleep and Wakeup Sample Code

standby_power_mode (RSL10 Evaluation [¥ Copy Standby Power Mode Sample Code
supplemental_calibrate (RSL10 Evaluation® Copy Supplemental Calibration Sample Code

Figure 6. Pack Manager Perspective: Examples Tab

3. The C/C++ perspective opens and displays your newly copied project. In the Project Explorer panel, you can
expand your project folder and explore the files inside your project. On the right side, the blinky.rteconfig file
displays software components. If you expand Device > Libraries, you can see the System library (libsyslib)
and the Startup (libcmsis) components selected for blinky (see Figure 7 on page 11).

NOTE: Sample projects are preconfigured with Release versions of RSL10 libraries, which are
distributed as object files. In the RTE configuration, you can switch to the Source variant to
include the source code of the library directly into your project (see Figure 7 on page 11).
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© onpencont ]

File Edit Source Refactor Navigate Search Project Run Window Help

=R R R T R R R R R I R R = TR L R = T W
15 Project Explorer &2 B®le® 770 [dsate & blinkprtecontig & =0
# & blinky & Components ®

A Includes

& AT Software Components Sel. Vanant Vendor Version Descniption

@ malng B Rsiin ONSemiconduc ARM Cortex-M3 43 MHz, 32 kB RAM, 334 kB ROM

# blinky.rteconfig + ® Device

¥ Bluetooth Profile;

readme_blinky.txt +
sectionsld ¥ Ubranes
S somsis [watves ¥ BLE O release JONSemiconduc 100 | Bluetooth Stack (libblelib)
. twatvce] alibrate release ericonduc 14 alibration Library (libcalibratelib)
5 >measure_rc_osc [watvcs| @ Calibe O re L ONsemicondue 100, Calibration Libeary (libealibratelib)
& remote_mic_nraw # Custom ProtocD)  release 2 ONSemiconduc 100 Low Latency Audio Streaming Customn Pretocel Library (libe
5 remote_mic_u_raw ¥ Flash O release L ONSemiconduc 100 , Flash Library (libflashlib)
¥ Kemel O release L ONSemiconduc 100 | Event Kemel Library (libkelin)
¥ Math 0O release 4 ONSemiconduc 100 Math Library {liomathlib)
* Remote Mic U release 4 ONSemiconduc 100 | Remote Microphone Library (libremate_miclib)
# System B release L ONSemiconduc 100 System Macros and Library (libsystit)
* Weak PRE O release |, ONSemiconduc 100 Weak Profile Library (weak_gprf)
¥ Startup B release L ONSemiconduc 100 RSL10-CMSIS Startup Library and Include Folders (libcmsis)
Validation Output Description

Camponents| Device Packs
Figure 7. RTE Configuration for the Blinky Example Project in the ON Semiconductor IDE

3.2.3 Build the Sample Code

Follow these steps to build the sample code:

1. Right click on the folder for blinky and click Build Project. Alternatively, you can select the project and click
the hammer icon shown in Figure 8.
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File Edit Source Refactor Navigate Search Project Run Window H

o |®m:@vﬁﬁv€v@’vv¢v0vggvﬂ
%o v= o N

5 Project Explorer 2 | B =
S '
8 Inc Go Into
. = De Open in New Window
> = inc Show in Local Terminal 4
L= Copy Ctrl+C
» e apy Paste Ctrl+V
@ blit 3¢ Delete Delete
=l rea Remove from Context Ctrl+Alt+Shift+Down
=l seq Source 4
Move...
Rename... F2
s Import..
3 Export.
€ CMSIS C/C++ Project 4
Build Project
Clean Project
Refresh
Close Project
Close Unrelated Projects

Figure 8. Starting to Build a Project in the ON Semiconductor IDE

2. When the build is running, the output of the build is shown in the ON Semiconductor IDE C/C++
Development Tooling (CDT) Build Console, as illustrated in Figure 9.
El Console &2

CDT Build Console [blinky]
13:43:57 **** Build of configuration Debug for project blinky ****
make all
"Invoking: Cross ARM GNU Print Size’
arm-none-eabi-size --format=berkeley “"blinky.elf”™

text data bss dec hex filename

1988 184 8 21ea 834 blinky.elf
'Finished building: blinky.siz'

13:43:58 Build Finished (took 584ms)
Figure 9. Example of Build Output

3. The key resulting output in Project Explorer includes:
»  blinky.hex: HEX file for loading into Flash memory

+  blinky.elf: Arm® executable file, run from RAM, used for debugging
»  blinky.map: map file of the sections and memory usage

These files are shown in Figure 10 on page 13.

NOTE: You might need to refresh the project to see the three built output files. To do so, right-click on
the project name blinky and choose Refresh from the menu.

www.onsemi.com
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B Project Explorer 12 | Bl 5

4 1% blinky
- %% Binaries
+ [ Includes
4 (= Debug
- [ app.o - [arm/le]
- % blinky.elf - [arm/le]
= app.d
= blinky.hex
= blinky.map
& makefile
@ objects.mk
& sources.mk
@ subdirmk
> = include
- & RTE
- lel app.c
4 blinky.rteconfig
=| readme_blinky.txt
=| sections.ld

=

Figure 10. Output Files from Building a Sample Project

ON Semiconductor

NOTE: If the ON Semiconductor IDE has trouble finding the GNU toolchain, it might be caused by
having other GNU toolchains installed. See Appendix B, “Arm Toolchain Support” on page 50

for more information.

3.3 DEBUGGING THE SAMPLE CODE

3.3.1 Debugging with the .elf File

Debug the application using the .elf file as follows:

1. Within the Project Explorer, right-click on the blinky.elf file and select Debug As > Debug

Configurations...

2. When the Debug Configurations dialog appears, right-click on GDB SEGGER J-Link Debugging and
select New. A new configuration for blinky appears under the GDB SEGGER heading, with new
configuration details in the right side panel.

3. Change to the Debugger tab, and enter RSL10 in the Device field. Ensure that SWD is selected as the target
interface (as shown in Figure 11 on page 14).

www.onsemi.com
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& Debug Configurations ==
Create, ge, and run confi i s
A
L] b Mame:  blinky
ype filte [ main |45 Debuggerl, - Startup| - Source| T Common
—- L+ Application o J-Link GDB Server Setup
[E1C/C++ Attach to Application | Start the J-Link GDB server locally Connect to running target
t] CfC++ Postmartem Debugger - — .
[€1€/C+ + Remote Application Executable: Slilink_path}/$(jlink_gdbserver} Browse... | Variables...
[£] GDB Hardware Debugging Device name:  RSLL0 Supported device names
4 [E] GDB SEGGER J-Link Debugging Endisnnesz @ Littie ig
(] blinky . -
Connection: @ USB P {USB serial or IP name/address)
¥ Launch Group
Interface: 9 5WD ITAG

Initial speed: Auto Adaptiv @ Fixed 1000 kHz
GDE port: 231

SWO port 2332 | Verily downloads || Initialize registers on start
Telnet port: 2333 | Local host only Silent
Log file: Browse...

Other options: -singlenun -strict -timeout 0
| Allocate console for the GDB server | Allocate console for semihosting and SWO
GDB Client Setup
Executable:  ${cross_prefixlgdbSicross_suffix} Browse...| | Variables...
Other options:

Commands:  set mem inaccessible-by-default off

Remote Target
Host name or [P address:

Port number:

Force thread list update on suspend

Filter matched B of & items

7 Debug Close

Figure 11. Setting Up a GDB Launch Configuration, Debugger Tab

NOTE: If you want to debug an application that does not start at the first address of flash memory, see
Chapter 6, “Advanced Debugging” on page 32.

4. Once the updates to the configuration are completed, make sure the Evaluation and Development Board is
connected to the PC via a micro USB cable, and click Debug. J-Link automatically downloads the blinky
sample code to RSL10’s flash memory.

NOTE: IfJ-Link does not automatically write your program to RSL10’s flash memory, make sure you

are using the J-Link version specified in Section 2.3, “Prerequisite Software” on page 6.

If you are having trouble downloading firmware because an application with Sleep Mode is on the Evaluation
and Development Board, see Section 6.4.1, “Downloading Firmware in Sleep Mode” on page 40.

5. The ON Semiconductor IDE asks if you would like to open the Debug perspective. Answer Yes, and click on
Remember my decision so that the question is not asked again.

6. The Debug perspective opens and the application runs up to the first breakpoint in main, as shown in Figure 12
on page 15. You can press F6 multiple times to step through the code and observe that the LED changes its
state when the application executes the function Sys GPIO Toggle (LED DIO).
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-
£ Oxygen2001 - blinky/main.c - Eclipse

i | @it~ O~ Q~-i®e & !
blw il vt Gw v

45 Debug = [+ v =8

4 [€] blinky [GDB SEGGER J-Link Debugging]
4 [ blinky.elf
4 o Thread #1 57005 (Suspended : Breakpoint)
= main() at main.c:139 0x1003de
sl JLinkGDBServerCLexe
4 arm-none-eabi-gdb
» Semihosting and SWV

teco 0x0 [ main.c 22 1 B

/* Initialize the system */
Initialize();

/* Spin loop */

while (1)

{
/* Refresh the watchdog time
Sys_Watchdog_Refresh();

/* Toggle GPIO 6 (if togglin
if (led_toggle_status == 1)

Sys_GPIO_Toggle(LED DIO)
} _
else
I S =
< | 111 »

=

128 Initialize();
Breakpoint 3, main () at ../main.c:134

134 Sys_Watchdog_Refresh();

4

-
File Edit Source Refactor Mavigate Search Project Run Window Help
@viBiw|mnme R 0lid | &%

El Console ¥ Tasks ¢! Problems (3 Executables &} Debugger Console 22 | I EmbSys Registers
blinky [GDB SEGGER J-Link Debugging] ${cross_prefix}gdb${cross_suffix} (277)

Quick Access = | BE®
% Brea.. 5“7 Exp Reg Mod Pei =08 | s
RBEEHAw|BEE ~ |0
& app.c [function: main] [type: Temporary]
«& main.c [line: 134]
[#]e mainc [line: 139]

No details to display for the current selection.

5= Outline FEERS % Y= 85
S rsl10h

CONCAT(
DIO_SRC()
BUTTON_DIO
LED_DIO
RECOVERY_DIO

" led_toggle_status : volatile uintd_t
DIO0_IRQHandler(void) : void
Initialize(void) : void
DIO0_IRQHandler(void) : void
Initialize(void) : void
main(void) : int

e e o T T ® # # # # #

EBE~=0

« [

Figure 12. Debug Perspective

3.3.2 Peripheral Registers View with the ON Semiconductor IDE

ON Semiconductor

The ON Semiconductor IDE includes a peripheral register view plugin that enables you to visualize and modify all
of the RSL10 registers during a debug session. It can be configured by setting the path to the SVD file in the Debug

session.

The following steps demonstrate how to configure and use the Peripheral Registers View with the Blinky

application:

1. Right click on the blinky.elf file, select Debug As > Debug Configurations, and open your configuration

details set, as described in Section 3.3.1, “Debugging with the .elf File” on page 13.

2. Change to the SVD Path tab, and set the path to the rsl10.svd file as
C:\Users\cuser_ id>\ON_Semiconductor\PACK\ONSemiconductor\RSL10\<pack_version>svd (see

Figure 13). Click Debug.
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£ Debug Configurations

Create, manage, and run configurations

B v -
iBX B3 Name: blinky Debug
type filter text | B Main [ % Debugger | & Startup | Source Common % SVD Path

SVD file (used by the peripheral registers viewer)
File path: C:\Users‘l:@l\ONjemimnductor\PACK\ON5emicnnductor\RSL1D\E.D‘SDE\SVG\rsIID‘svd Variables...

C/C++ Application

C/C++ Attach to Application
C/C++ Postmortem Debugger
C[C_++ Remrj\te /f\ppllcatlon <user_id>
Eclipse Application

GDB Hardware Debugging

GDB OpenOCD Debugging

GDB SEGGER J-Link Debugging

[2] blinky Debug

E1 Java Applet

[ Java Application

Ju JUnit

Ju JUnit Plug-in Test

@ Launch Group

@ Launch Group (Deprecated)

[Bl Mwe?2 Launch

4 0SGi Framework

IZ. Remote Java Application

PIFIE @ FEEE

Filter matched 18 of 104 items | Revert ‘ ‘ Apply |

C?:' | Debug ‘ | Close }

Figure 13. SVD Path Tab Perspective

3. In the Debug perspective, when the application runs up to the first breakpoint in main, open the Peripherals
window view, by navigating to Window > Show View > Other > Debug > Peripherals and clicking Open.
Now you can see all the RSL10 peripherals displayed.

4. Select the peripheral that you need to monitor, and open the Memory window to show the RSL10 peripheral
registers. The read only registers are highlighted in green. If you wish, you can drag your Memory window and
place it side-by-side with your source code view (see Figure 15 on page 18).

5. Select DIO and CLK in the peripherals window. Now you can monitor the selected peripherals from the
Monitors tab and switch between them. To see or change the DIO register status, choose DIO and expand the
DIO > DIO_DATA register in the Memory window.

6. Press F6 to step through the code. You can observe that this register’s bit 6 toggles its state when
Sys_GPIO Toggle (LED DIO) is executed. The register turns yellow to indicate that you have activated
real-time monitoring for it. (see Figure 14).
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S eclipse-workspace - bli - Eclipse ol
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+ [E] by Debug [GDB SEGGER J-Link Debugging] Peripheral Address  Description |8

Dlinky.eit 7 BBF Ded0001400 Baseband Controller Interface

# o Thread #1 57005 (Suspended : Breakpaint) v 40000200 Clock Generation
= main{) at app.c124 0x100400 ¥ CRC (nAQOOOFDD  CRC Generator Contral
o Lk GDBSanverCLene 7. DEBUG EDOOEDFD Detbug Controller
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o Semihosting snd SWV 40000700 D40 Interface and Digital Pad control

% DMA DMA Controller C ion and Control =
n

8 appe & Y D Memory 1 - (B T Ovthoe 1 -n
118 led_toggle_status = 1; = Monitors g 3 e 7, 00; (0000700 11 New Renderings. TEARY e R
2 . - Address Value -
- . @ 0K 0070  apph
: Initialize(); 00 *  DIO0_IRQHandlerly
. = Spin Loop *f Tnitializelvoid) - v
115 /* Spin loop = 111 otk =
116 while (1) 154} eFO50 = o * mainivold) : int
ur o [54) 0aF0E0
118 * Refre timer
= DIO_DIR 40000744 Q00008040
119 Sys_Watchdog_Refresh();
e Rt R & > B DIO_MODE eA0000748 Cx00000060
* Toggle GPIO 6 ( £ DIO_INT CFGT) A0000T4C
if (led_toggle_status = DIOINTDEBOUNCE  0wd000075C 00000131
{ = DIO_PCM_SRC 4000076 000111111
Sys_GRIO_Toggle(LED_DIO0); i DI0_SPLSAC] DxA00007E4
= DIO_UART SRC Ow40000TEC 000000011
slse DHO_I2C_SRC 0000770 00001111
Sys_GPI0_Set_Low(LED_DID); CHO_ALDHOSINE SRC 40000774 000000011
} DHO_NMI_SRC eA0000TTE 00000030
Sys_Delay_PrograsROM((uint32_t)(8.5 * SystesCoreClock 0B8R SAC eA0000TIC 0121212
= DHO_BE_SPLSAC ei00007ED 0000012
} HO_RE_SPISRC eA0000TES Cw00121212
' = DIO_RF GPIDO3 SRC  Owd00007ES (12121010
. T » = DIO_RF_GPIOAT SRC Ow40000TEC 010101012 - . " I3
B 2 Tasks % B sxk| AP ~g-n~=
binky Debug [GDB SEGGER I-Link Debugging] LinkGDBServerCLexs
Read 4 bytes @ sddress Bx00100480 (Data = OxF7FF2006) -
Removing breakpoint @ address 800100480, Size = 2
Reading 24 bytes @ address x40000100
Reading 168 bytes @ address 8x40008700
Downloading 4 bytes § address 0xd0000748 - Verify failed
Reading 168 bytes @ address 8x40008700 E
] 5

Figure 14. Peripheral Registers View Perspective in Debug Session After Setting SVD Path

7. Click on the Value tab of the GPIO register to change the (HIGH/LOW) state of GP1O6, as shown in
Figure 15. You can observe that the LED (DIO6) on your board changes its state.
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@ GPIO

DIO_DIR

DIO_MODE
DIO_INT_CFG[]
DIO_INT_DEBOUNCE
DIO_PCM_SRC
DIO_SPI_SRC(]
DIO_UART_SRC
DIO_I2C_SRC
DIO_AUDIOSINK_SRC
DIO_NMI_SRC
DIO_BB_RX_SRC

i DIO_BB_SPLSRC
i DIO_RF_SPL_SRC

DIO_RF_GPIOD3_SRC
DIO_RF_GPIO47_SRC
DIO_RF_GPIOB9_SRC

Address
0x40000700
0x40000700
0x40000740
[15:0]

[15:0]
0x40000744
0x40000748
0x4000074C
0x4000075C
0x40000760
0x40000764
0x4000076C
0x40000770
0x40000774
0x40000778
0x4000077C
0x40000780
0x40000784
0x40000788
0x4000078C
0x40000790

Value

0x0000F060
0xF060
0x0: GPIOO_LOW

»

0x0: GPIO12_LOW
0x0: GPIO13_LOW
0x0: GPIO14_LOW
0x0: GPIO15_LOW
0Ox1: GPIOO_HIGH
0x2: GPIO1_HIGH
Ox4: GPIO2_HIGH
0x8: GPIO3_HIGH
0x10: GPIO4_HIGH
0x20: GPIO5_HIGH

0x80: GPIO7_HIGH
0x100: GPIO8_HIGH
0x200: GPIOS_HIGH
0x400: GPIO10_HIGH
0x800: GPIO11_HIGH
0x1000: GPIO12_HIGH
0x2000: GPIO13_HIGH

0x4000: GPIO14_HIGH
0x8000: GPIO15_HIGH

0x40; GPIO6_HIGH

m

m

]k

Figure 15. Toggling RSL10 DIO Using the Peripheral Registers View
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CHAPTER 4

Getting Started with Keil

4.1 PREREQUISITE SOFTWARE

Download and install the Keil pVision IDE from the Keil website, using the vendor’s instructions.

4.2 RSL10 CMSIS-PACK INSTALLATION PROCEDURE

To install the RSL10 CMSIS-Pack:

1. Open the Keil pVision IDE and navigate to Project > Manage > Pack installer or click on the icon shown in
Figure 16.

File Edit View Project Flash Debug Peripherals Tools SVCS  Wine

== - ey Y | | m |;§;§G
2 E B e |?§‘Target1 m#ﬁ‘ﬁ & 4 @

Figure 16. Pack Installer Icon

2. Click on File > Import, select your pack file ONSemiconductor.RSL10.version.pack, and click Open
(see Figure 17). version is the RSL10 version, such as 2.2.347.

(&8 Import Packs Ex
@Ow| » Computer » SYSTEM (C:) » cmsis_pack_Keil v‘ 4y H Search cmsis_pack Keil P |
Organize New folder = 1 @
- Favorites *  Name Date modified Type
B Desktop | [ ONSemiconductor.RSL10.2.2.347 10/31/2018 429 PM  uVisior
: }4 Downloads i
@ Pack Installer - C:\Keil_vS\ARM\PACK
=% R it Pl
Packs Window Help ittt =
Refresh v
~| Libraries
Import... ET -
Import from Folder... % Documents
Manage Local Repositories... Pack 4. Music -
B Summary =De £, Pictures
eI T 5734 Devices = | * B videos
& Computer
=¥ SYSTEM (C) - ] 1l | I
File name: ONSemiconductor.RSL10.2.2.347 - [Sof‘tware Pack - PACK (*zip; ']
[ Open ‘V} | Cancel |

Figure 17. Installing the RSL10 CMSIS-Pack for the Keil uVision IDE

3. The IDE prompts you to read and accept our license agreement, then installs the RSL10 CMSIS-Pack in the
C:\Keil_v5 folder.

4. After installation, use File > Refresh as shown in Figure 18 to update your pack proprieties.
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@ Pack Installer - C:\Keil_v3\ARM\PACK

Packs Window Help

Refresh

Import... b ﬂ/
Import from Folder...

Manage Local Repositories... Pack

Fwit

Summary =-De

Figure 18. Refresh Pack after installation

5. The RSL10 CMSIS-Pack now appears in the list of installed packs. In the Devices tab, if you expand All
Devices > ONSemiconductor > RSL10 Series, you can see RSL10 listed there. You can manage your
installed packs in the Packs tab. Expanding ONSemiconductor.RSL10 makes the Pack Properties tab display
the details of the RSL10 CMSIS-Pack. Figure 19 on page 20 illustrates what the Pack Installer perspective
looks like after installation.

@ Pack Installer - C:\Keil_vS\ARM\PACK
File Packs Window Help
.721 | Device: ONSemiconductor - RSL10

j Devices Boards | ﬂ ﬂ ,’/ Packs # Examples
Search: ¥. }Q‘ r Show examples from installed Packs only
Device o | Summary Example Action ‘ Description

Maxim 9 Devices ‘:! ~~ADC_UART (RSL10 Evaluation Board)| % Copy | ADC with UART S:
MediaTek 2 Devices : ble_central_client_bond (R5L10 Eval... & Copy BLE Central Client
Microchip 345 Devices - ble_central_client_scan (RSL10 Eval.. |€ Copy Pairing and Bondi
Microsemi 6 Devices ~ble_peripheral_server_bond (RSL10 ... & Copy BLE Peripheral Ser
MindMotion 2 Devices ~ble_peripheral_server_hrp (RSL10 Ev... & Copy Pairing and Bondi
Nordic Semiconductor 13 Devices ~blinky (RSL10 Evaluation Board) & Copy Blinky GPIO I/O Sz
Nuvoton 487 Devices = -default_MANU_INFO_INIT (RSL10 E... & Copy Default System Ini
NXP 1223 Devices ; ~hci_app (RSL10 Evaluation Board) & Copy Host Controlier Inv
ONSemiconductor 1 Device i2c_cmsis_driver (RSL10 Evaluation .. & Copy 12C CMSIS-Driver |

a-% RSL10 Series 1 Device kernel_timer (RSL10 Evaluation Boa..| ¥ Copy Kernel Timer Sam|

- 0 ARM Cortex-M3, 48 MHz ~measure_rc_osc (RSL10 Evaluation ... & Copy Measure 32 kHz R

Redpine Signals 2 Devices : -peripheral_server_standby (RSL10 E... & Copy Peripheral Device
Renesas 4 Devices ~spi_cmsis_driver (RSL10 Evaluation ... & Copy SPI CMSIS-Driver ¢
Silicon Labs 783 Devices : ~supplemental_calibrate (RSL10 Eval... & Copy Default System Ini
Sinowealth 1 Device : ~uart_cmsis_driver (RSL10 Evaluation.. & Copy UART CMSIS-Drive
SONiIX 30 Devices =
STMicroelectronics 1061 Devices
Texas Instruments 350 Devices _,j 1 I

Output

Update available for Kell:ARM_Compiler (installed: 1.3.3, available: 1.4.0)
Update available for Keil:MDK-Middleware (installed: 7.5.0, available: 7.6.0)

Update available for ONSemiconductor:RSL10 (installed: 2.3.27, available: @version@)

Ready

Figure 19. Pack Installer after RSL.10 CMSIS-Pack is Installed in the Keil nVision IDE

4.3 BUILDING YOUR FIRST SAMPLE APPLICATION WITH THE KEIL UVisiON IDE

This section guides you through importing and building your first sample application, named blinky. This
application makes the LED (DIO6) blink on the Evaluation and Development Board.

For more information about the sample applications, see the RSL10 Sample Code User’s Guide.
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4.3.1 Import the Sample Code

To import the sample code:

1. In the Pack installer, click on the Examples tab to list all the example projects included in the RSL10
CMSIS-Pack.

2. Choose the example project called blinky, and click the Copy button to import it into your workspace (see
Figure 20 on page 21). Choose a destination folder for a copy of the sample code.

&8 Packs [ Examples & O Only show examples from installed packs ‘ @‘ &= Y70

Search Example

Example Action Description
blinky (RSL10 Evaluation Board) 2 Copy . Blinky GPIO I/O Sample Code
central_client (RSL10 Evaluation Board) % Copy Central Device with Client Sample Code
central_client_double (RSL10 Evaluation B #* Copy Central Device with Client Sample Code - Double
central_peripheral (RSL10 Evaluation Boar# Copy Central Peripheral Device Sample Code
custom_protacol_trx (RSL10 Evaluation B Copy Low Latency Audio Sample Application with Custom Prot...
default MANU_INFO_INIT (RSL10 Evaluati € Copy Default System Initialization Function
hci_app (RSL10 Evaluation Board) % Copy Host Controller Interface Application
pair_bond (RSL10 Evaluation Board) % Copy Pairing and Bonding with Peripheral Device Sample Code
pair_bond_master (RSL10 Evaluation Boar# Copy Pairing and Bonding with Central Device Sample Code
peripheral_server (RSL10 Evaluation Boarc® Copy Peripheral Device with Server Sample Code
peripheral_server_FOTA (RSL10 Evaluatior|¥ Copy Peripheral Device with Server for Sending Firmware Over ...
peripheral_server_hrp (RSL10 Evaluation B'¥ Copy Heart Rate Peripheral Device with Server Sample Code
peripheral_server_sleep (RSL10 Evaluation# Copy Sleep Mode Sample Code for Peripheral Device with Serv...

sleep_ble_advertisements (RSL10 Evaluati|$ Copy Sleep and Wakeup with Bluetooth Low Energy Technolog...
sleep_RAM_retention (RSL10 Evaluation B/# Copy Sleep and Wakeup Sample Code

standby_power_mode (RSL10 Evaluation [¥* Copy Standby Power Mode Sample Code
supplemental_calibrate (RSL10 Evaluation# Copy Supplemental Calibration Sample Code

Figure 20. Pack Manager Perspective: Examples Tab

Sample projects are preconfigured with Release versions of RSL10 libraries, which are distributed as object files.
For Keil, System library (libsyslib) and Startup (libcmsis) are preconfigured with the Source variant, so the source
code of those libraries is included directly (see Figure 21 on page 22).
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File Edit View Projct Flash Debug Penpherals Tools SVCS Window Help

Sdd s oal | B RIEE XA Flas| @-e & alTF
& (5 68 8- 3| §¥ Targer 1 ﬂRIﬁ"—Q‘}é
Project 8 & | L Manage Run-Time Environment (=5=]
= "4 Project blinky - - —
5 & Target1 Software Component Sel. Variant Version Description
B Source = ® Device Starup, System Setup -/
s J appc ¥ Starup I SOURCE 100 System Startup for ON Semiconductor RSLLD
X oo
3 apph = ® Libraries
% peice ¢ Weak PRF [~ |retease Weak Profile Library (weak prf)
s 91 1s110_protocol.c (LibrariesSystem) ¥ System I s0urce System Macros and Library (libsyslibl
a & rs110_romvectc (LibrariesSystem) ¥ Remote_Mic [~ source Remate Microphone Library (libremaote miclib)
3 & rs110_sys_asrcc (LibrariesSystem) ¢ Math [ souce Math Ligrary [liomath i)
5 51 rs110_sys_audio.c (LibrariesSystem) ° Kemel [ release Event Kemel Litrary llitkelio!
a2 rs110_sys_clocksc (Libraries:System) ¥ Flash [~ source Flash Libray (libflashlib)
a & rs110_sys_crec (LibrariesSystem) ¥ Custom Protocol [~ source Low Latency Audio Streaming Custom Protocel Library (ibcustom pratos
a & rs110_sys_dma.c (Libraries:System) ¥ Calibrate [~ source Calibration Library {libcalibratelib)
a 8 rsl10_sys_flash.c (LibrariesSystemn) ¢ BLE - release Bluctoath Stack (igblelio:
0 # rei10_sys_pewer.c (LibrariesSystem) w ® File System MDK-Plus File Agcess on various storage devices
o & rsl10_sys_power_maodesc (LibrariesSystem) & Grapnics MPEK-Flus MegrIntartace on graphical LD displays
0 81 rs110_sys_rMe.c (LibrariesSystem) w & Network MDK-Plug Py Networking using Ethemet or Serial protocols
0 81 rs110_sys._timers.c (LibrariesSystem) w® yss MDK-Plug WISE Commuynication with various device classes —
0 T rsi10_sys_uarte (LibrariesSystem) |
a & rel10_sys_version.c (LibrariesSystem) Validation Cutput Description
J startup_rsi10s (Startugp)
0 system_rsi10.c (Startup)

| | *I| [ Resove | [selectPacks) [ Detais [ o | comm elp
Elproect [@eccrs | O Fancions | Oy Tempiot

Figure 21. RTE Configuration for the Blinky Example Project in the Keil nVision IDE

4.3.2 Build the Sample Code

Build the sample code as follows:

1. Right click on Target 1 and choose Rebuild all target files. Alternatively, you can use the icon shown in the
Figure 22.
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
MNada s ai9 ¢ 1 = U5 | 2
\‘f @';ﬂlngarge‘tl F|$\|ﬁ%‘9@

Mo My

Praoject 1 @
=% Project: blinky
B4 Target 1 =
5.6 Source A% Options for Target ‘Target 1'... Alt+F7
a app.c Add Group...
=5 include &4 Manage Project Items...
3 app.h Open Map File
ER 4 Device Open Build Log
i rsI10_protocol.c #H Rebuild all target files
i rsl10_romvect.c [£ Build Target F7
% rs110_sys_asrc.c |7‘ Show Include File Dependencies

Figure 22. Starting to Build a Project in the Keil uVision IDE

2. When the build is running, the output of the build is shown in the Build Output view in the IDE, as illustrated
in Figure 23.
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Build Output

*** Oaing Compiler 'V5.06 update € (build 750)', folder: 'C:\Keil v5\ARM\ARMCC\Bin"
Build target 'Target 1°'

compiling app.c...

linking...

Program Size: Code=1508 RC-data=32 RW-data=4 ZI-data=3076

FromELF: creating hex file...

".\Cbjects\blinky.axf" - 0 Error(s), 0 Warning(s).

Build Time Elapsed: 00:00:02

Figure 23. Example of Build Output

3. The key resulting output in Project Explorer in the IDE includes:
»  blinky.hex: HEX file for loading into Flash memory
+  blinky.axf: Arm® executable file, run from RAM, used for debugging
»  blinky.map: map file of the sections and memory usage

4.3.3 Debugging the Sample Code

4.3.3.1 Preparing J-Link for Debugging

Before debugging with J-Link, go to C:\Keil_v5\ARM\Segger and make sure that the folder contains a JL2CM3.dll
file. As well, make sure that you have installed the latest version of J-Link and have run the J-Link DLL Updater, as
shown in Section 2.3, “Prerequisite Software” on page 6.

4.3.3.2 Debugging Applications
The IDE’s debug configurations are already set in the CMSIS-Pack. To debug an application:

1. Make sure the Evaluation and Development Board is connected to the PC via a micro USB cable.
2. Select Debug > Start/Stop Debug Session or click the icon shown in Figure 24.

File Edit View Project Flash [Debug | Peripherals Tools SVCS Window Help

= =] | 1 | @) Start/Stop Debug Session Ctri+F5  flconst union gapc d|~ | 54 ||
A ‘ o ‘ Targe y Energy Measurement without Debug
Project S5 Reset CPU

Figure 24. Start/Stop Debug Session Icon

If you are having trouble downloading firmware because an application with Sleep Mode is on the Evaluation
and Development Board, see Section 6.4.1, “Downloading Firmware in Sleep Mode” on page 40.

3. The application runs up to the first breakpoint in main, as shown in Figure 25. You can press F11 multiple
times to step through the code and observe that the LED changes its state when the application executes the
function Sys _GPIO Toggle (LED DIO).
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File

Edit View Project Flash Debug
| =

Peripherals Tools

1G53 | | ®

SVCS Window Help

12 15| const union gapc_dm 2@

LR CR ]

SRR BEE A =R R
Project 2 [B] Disassembly 1 @
=% Pproject: blinky 0x00100540 7300 LDRS x0, [0, $0x00] -
1 0x00100542 2301 cMp r0, $0x01
B Target1 0x00100544 D116 BNE 0%00100574
2 Source 124: Sys_GPIO Toggle (LED DIO);
125: H
B app.c 126: else
o 127: {
include 0x00100546 2006 MOVS 0, $0x06
. J apph 79: if({((uintd_t)DIO->CFGlgpio_pin] & DIO CFG IO MODE GPIO Mask) == 0)
. 20: 4 -
=% Device e e e _
& rsI10_protocol.c (Libraries:System) < [m] »
ﬁ rsl10_romvect.c (Libraries:System) J app.c _1 startup_rsi10.s - X
ﬁ rsl10_sys_asrc.c (Libraries:System) 10801 N
A 15110 sys_audio.c (Librariessystem) 109 /*Initialize global variables */
& rsl10_sys_clocks.c (Libraries:System) 110 led_toggle_status = 1;
& rs110_sys_cre.c (Libraries:System) 111
BT rs110_sys_dma.c (Libraries:System) 112 /* Initialize the system */
ﬁ rsl10_sys_flash.c (Libraries:System) iﬁ' Initialize();
ﬁ rsl10_sys_power.c (Libraries:System) 115 /* spin loop */
ﬁ rsl10_sys_power_modes.c (Libraries:System) 116 while (1)
& rs110_sys_rffe.c (Libraries:System) 117H {
BT rs10_sys_timers.c (Libraries:System) 118 /* Refresh the watchdog timer */
ﬁ rsl10_sys_uart.c (Libraries:System) i;g Sys_Watchdog_Refresh 07
2T rs110_sys version.c (Libraries:System) 121 /* Toggle GPIO 6 (if toggling is enabled) then wait 0.5 secor
B startup_rsl10.s (Startup) 122 if (led_toggle_status == 1)
a system_rs|10.c (Startup) 123 H {
L 124 5ys_GPIO_Toggle (LED_DIO) ;
125 - }
‘ j 126 else
1275 { T
Project < | i | »
Command a2 \§| Call Stack + Locals a2 \§|
I “ | Name Location/Value Type
Device: RSL10
VTarget = 3.300V ¥ main 0x00000000 int f()
State of Pins: TCK: 0, TDI: 1, TDO: 1, TMS: 1, TRES: 1, TRST: 1
Hardware-Breakpoints: 2
Software-Breakpoints: 8192
Watchpoints: 1
JTAG speed: 2667 kHz

#* JLink Info: J-Link: Flash download:

JLink Info: Executing RSL10 reset type:
BS \\blinky\app.c\124

0x00000000

< | 1

Load "C:\\Users\\zbhn3b\\Desktop\\cmsisp\\Files\\source\\samples\\keil\\b1i|
Bank 0 @ 0x00100000:

Skipped. Content|=

>

ASSIGN BreakDisable BreakEnable BreakKill BreaklList BreakSet BreakAccess

\#aCall Stack + Locals | ElMe

J-LINK / J-TRACE Cortex t1: 0.00000000 sec

Figure 25. Debug Session in the Keil nVision IDE

NOTE: Debug configurations are preconfigured for the sample applications in the IDE’s CMSIS-Pack.
Flash downloading through the Download icon (Figure 26) or F8 is not supported for J-Link in
the IDE at this point. The IDE may add support for this feature in future releases.

| File | Edit View Project Flash Debug Peripherals

Project

Figure 26. Download Button Not Supported for J-Link
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CHAPTER 5

Getting Started with 1AR

5.1 PREREQUISITE SOFTWARE

Download and install the IAR Embedded Workbench from the JAR Website, using the vendor’s instructions.

5.2 RSL10 CMSIS-PACK INSTALLATION PROCEDURE

To install the RSL10 CMSIS-Pack:

1.  Open the IAR Embedded Workbench and expand File > New Workspace to open a new workspace, then go to
File > Save Workspace As and choose the location for your workspace.
2. Navigate to Project > CMSIS Pack Manager, or click on the icon shown in Figure 27.

File Edit View Project J-Link Tools Window Help
DAR@ B XK O2C -\Q/S'E<U>UUI.-EO>;@7—

Figure 27. Pack Installer Icon

3. Click on CMSIS Manager > Import Existing Packs, select your pack file
ONSemiconductor.RSL10.version.pack, and click Open (see Figure 28). version is the RSL10 version,
suchas 2.3.27.

a Import Packs @l
@Ov| » Computer » SYSTEM (C) » cmsis_pack IAR v|¢f H Search cmsis_pack IAR }3‘
Organize ~ New folder = O @
M Desktop “  Name Date modified Type
4 Downloads :
3 & ONSemiconductor.RSL10.2.3.27.pack 5/6/2019 2:43 PM uVision
@ IAR Embedded Workbench CMSIS Manager = Recent Places
File Edit Search |CMSIS Manager | Window Help |3
: Qi Apply RTE changes Ctrl+Shift+S o Libraries
Remove Unused Files “. Documents
% Import Existing Packs & Music
t23 Import Packs from Folder =. Pictures
&7 Create files from CMSIS Template... K videos
& Computer
~¥ SYSTEM () x| T 1 ’
File name: ONSemiconductor.RSL10.2.3.27.pack x ‘Pack Files (*.pack) v|
l Open |VI | Cancel ‘

Figure 28. Installing the RSL10 CMSIS-Pack for the IAR Embedded Workbench IDE

4. The IDE prompts you to read and accept the license agreement, then installs the RSL10 CMSIS-Pack in the
CMSIS-Pack root folder.

5. After installation, click on the refresh icon with yellow arrows, which shows the text Reload Packs in the
CMSIS Pack root folder when you hover over it with your cursor, in the Packs tab (as shown in Figure 29), to
update your pack proprieties.
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@5 Packs 2 M Devices B Boards [ Examples & Console = Pack Properties =~ O

2 EI@e el o -

Pack Action Description

Search Pack

Figure 29. Refresh Pack after installation

6. Inthe Devices tab, expand All Devices > ONSemiconductor > RSL10 Series, and select RSL10 from the list.
The RSL10 CMSIS-Pack now appears in the list of installed packs in the Packs tab. Expanding
ONSemiconductor.RSL10 makes the Pack Properties tab display the details of the RSL10 CMSIS-Pack.

Figure 30 on page 26 illustrates what the Pack Manager perspective looks like after installation.

@ IAR Embedded Workbench CMSIS Manager [ o
File Edit Search CMSIS Manager Window Help
Quick Access || 5 |[@)

Qg ~ - - oo -

= B @ Packs 2 M Devices Boards = Pack Properties [ Examples & Console AR s EBm® =8
Search Pack
Pack Action Description
4 ® Device Specific 1 Pack RSL10 selected
4 % ONSemiconductor.RSLLO 6’ Up o dali ON Semiconductor RSL10 Device Family Pack
24450 % Remove  www.onsemi.com
* Generic Software Packs with generic content not specific to a devi...

Figure 30. The IAR Embedded Workbench CMSIS Manager after RSL10 CMSIS-Pack is Installed

5.3 BUILDING YOUR FIRST SAMPLE APPLICATION WITH THE IAR EMBEDDED WORKBENCH

This section guides you through importing and building your first sample application, named blinky. This
application makes the LED (DIOG6) blink on the Evaluation and Development Board. The procedure described in this

section assumes that you have installed the SDK.

For more information about the sample applications, see the RSL10 Sample Code User’s Guide.
5.3.1 Import the Sample Code

Import the sample code to your workspace as follows:

1. Inthe IDE’s CMSIS Manager, click on the Examples tab to list all the example projects included in the RSL10
CMSIS-Pack.
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2. Choose the example project called blinky, and click the Copy button to import it into your workspace (see
Figure 31 on page 27). Choose a destination folder for a copy of the sample code.

@ Packs M Devices B Boards [ Examples ¢ [ Console

Search Example

Example Action

ADC_UART (RSL10 Evaluation Board)

ble_central_client_scan (RSL10 Evaluation \_‘ Copy

ble_peripheral_server_bond (RSL10 Evalua\_’ Copy
ble_peripheral_server_hrp (RSL10 Evaluatiw\_‘ Copy |
. Blinky GPIO I/O Sample Code

. Default System Initialization Function

blinky (RSL10 Evaluation Board) \_’ Copy

default_MANU_INFO_INIT (RSL10 Evaluati \_‘ Copy

& Copy
| 12C CMSIS-Driver Sample Code
& Copy
. Measure 32 kHz RC Oscillator

hci_app (RSL10 Evaluation Board)
i2c_cmsis_driver (RSL10 Evaluation Board)\_‘ Copy
kernel_timer (RSL10 Evaluation Board)
measure_rc_osc (RSL10 Evaluation Board)\_‘ Copy

peripheral_server_sleep (RSL10 Evaluatian\_’ Copy |
| Peripheral Device with Server and Standby Power Mode S...
. SPICMSIS-Driver Sample Code

peripheral_server_standby (RSL10 Evaluati\_‘ Copy

spi_cmsis_driver (RSL10 Evaluation Board)\_’ Copy
supplemental_calibrate (RSL10 Evaluation\_‘ Copy |
. UART CMSIS-Driver Sample Code

uart_cmsis_driver (RSL10 Evaluation Buarc\_’ Copy

% Copy
ble_central_client_bond (RSL10 Evaluatior\_’ Copy |
. Central Device with Client Scanner Sample Code
. BLE Peripheral Server Bonding Sample Code

Description

. ADC with UART Sample Code

BLE Central Client Bonding Sample Code

Heart Rate Peripheral Device with Server Sample Code

Host Controller Interface Application

Kernel Timer Sample Code

Sleep Mode Sample Code for Peripheral Device with Serv...

Default System Initialization Function

Figure 31. IAR Embedded Workbench CMSIS Manager: Examples Tab

O Only show examples from installed packs ‘ o R B @\ @ ¥ °

Sample projects are preconfigured with Release versions of RSL10 libraries, which are distributed as object files.
For the IDE, System library (libsyslib) and Startup (libcmsis) are preconfigured with the Source variant, so the source
code of those libraries is included directly in both CMSIS Manager and IDE windows (see Figure 32 on page 27 and

Figure 33 on page 28).

@ blinky/blinky.rteconfig - IAR Embedded Workbench CMSIS Manager
File Edit Source Refactor Navigate Search Project CMSIS Manager Run Window Help

mifh | &~
5 Project Explorer &2
41 blinky
- = Debug
» & include
4 5 RTE
4 [= Device
4 (= RSL10
[& rsl10_protocol.c [O
[& rsI10_romvect.c [t
[ rsl10_sys_asrc.c
[ rsl10_sys_audio.c
[& rsl10_sys_clocks.c
[ rs110_sys_cre.c
[ rsl10_sys_dma.c [
[ rsl10_sys_flash.c [ONSemic
[ rsl10_sys_power_modes.c
[ rsl10_sys_power.c [ONS
[ rsl10_sys_rffe.c [C
[ rsl10 _sys timers.c [C
[& rsl10_sys_uart.c
[ rsI10_sys version.c
|8l startup_rsl10.s [O
[g system_rsi10.c
[El RTE_Components.h

i E Y G @vinitr O Gi® v R R

B S

¥ T B | & blinky.rteconfig &

& Components |

Software Components Sel. Variant
B Rsiio
4 % Device
+ % Bluetooth Profile
4 ¥ Libraries
¥ BLE O release
“ Calibrate O source
# Custom Protoc]  source
“ Flash U source
¥ Fota O release
“ Kernel O release
¥ Math O source
“ Remote Mic O source
¥ System source
¥ Weak PRF O  release
¥ Startup source

Vendor Version

ONSemiconduc

. ONSemiconduc 24450
ONSemiconduc 2.4.450
ONSemiconduc 24450
ONSemiconduc 2.4.450
ONSemiconduc 24450

, ONSemiconduc 2.4.450
ONSemiconduc 24450
ONSemiconduc 2.4.450
ONSemiconduc 24450

, ONSemiconduc 24450
ONSemiconduc 24450

Description
ARM Cortex-M3 48 MHz, 24 kB R

, Bluetooth Stack (libblelib)

i Calibration Library (libcalibrateli
, Low Latency Audio Streaming Cu
Flash Library (libflashiib)

, Fota Library {libfota)

P Event Kernel Library (libkelib)

mathlib)

4
. Remote Microphone Library (i

. System Macros and Library (libsy
b Weak Profile Library (weak_prf)
 System Startup for ON Semiconc

< |

Validation Output

Description

Figure 32. RTE Configuration for the Blinky Example Project in the IAR Embedded Workbench CMSIS Manager

window
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File Edit View Project J-Link Tools Window Help

|Debug =
Files 8 .
L blinky - Debug |« [ |

—& W CMWSIS-Pack

— RIRTE_Componentsh

}—E_\ W Device Startup source

| &) startup_rsl10.s

| H [ systern_rsi10.c

L5 m Device Libraries System source
rsl10_protocal.c
rzl10_ramvectc
rsl10_sys_asrc.c
rsl10_sys_audio.c
rsl10_sys_clocks.c
[ rsl10_sys_cree
rsl10_sys_dma.c
rsl10_sys_flash.c
rsl10_sys_power.c
rsl10_sys_power_modes
rs10_sys_rffe.c
110_sys_timers.c
rs10_sys_uartc
[ rs10_sys_wersion.c
M include
Bappc
— B readme_blinky: bt
& Output

'

bhdhbhohehohd D

Over\/\ewl ble_peripheral_server_bond ” blinky

Figure 33. RTE Configuration for the Blinky Example Project in the IAR Embedded Workbench window

5.3.2 Building the Sample Code

To build the sample code:

1. Right click on the folder for blinky and choose Rebuild all. Alternatively, you can use the icon shown in
Figure 34.

File Edit View Project J-Link Tools Window Help

=8 ]blinky - Debug
2 B CMEIS-Fack
| — R RTE_Componentsh

| W Device. Startup source

| L& m Device Libraries. System so
| B rsl10_pratocal.c
I o]

Options...
Make
Compile
Rebuild All
Clean

rsll D:sys_asrc c

Figure 34. Starting to Build a Project in the IAR Embedded Workbench
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2. When the build is running, the output of the build is displayed in the Build Output view in the IDE, as
illustrated in Figure 35.

Files &

El @ blinky - Debug M
Build M include

& app.c

|— B readrme_klinky:bt

Waseages @ m CMSIS-Pack
- h -Facl
Building configuration: blinky - Debug & Output

Updating build tree

rs10_sys_croc
rs10_sys_dma.c
rsl10_sys_flash.c
rsl10_sys_power.c
rsl10_sys_rffe.c
rsl10_sys_power_tnodes.c
rsI10_sys_tirners.c
510 _sys_uart.c
1sl10_sys_version.c
system_rsl10.c
Linking

blinky.out
Corwerting

Taotal number of errars: 0
Total number of warnings: 0

Build | Debug Log

startup_rsl10 s 'l—_E % E:::ll:y.runl:p
rsl10_protocol.c Lk

1 B Output
rsl10_romvectc — D blinky.h
rsl10_sys_asrc.c Lg b\:zk;i.megp
zﬁrﬂ.csys audio.c — Dappao
rel10_sys_clocks & R B :;m—::n;

— [rsl10_protocol.o
— O rs0_ramvecto
— DOlrsl0_sys_ssrco
F— DO rs0_sys_audio o
— [1rsl10_sys_clocks.o
F— [ rsl10_sys_crco
F— [ rsl10_sys_dma.o
F— DCirsl10_sys_flasho
F— Dirsl10_sys_power.o
F— O rs0_sys_power_modes.o
F— DOirsl10_sys_rfea

— [lrsl10_sys_timers.o
— [1rsl10_sys_uarto
— [ rsl10_sys_version.o
— Ot _tla

— B sections.icf

— Ol shb_la

— O startup_rs 0.0

L— [ system_rsli0.ao

Figure 35. Example of Build Output

3. The key resulting output shown in Project Explorer in the IDE includes:
*  blinky.hex: HEX file for loading into flash memory
*  blinky.out: Arm executable file, used for debugging
*  blinky.map: map file of the sections and memory usage

5.3.3 Debugging the Sample Code

5.3.3.1 Debugging Applications

IDE debug configurations are already set in the CMSIS pack. To debug an application:

1. Make sure the Evaluation and Development Board is connected to the PC via a micro USB cable.
2. Select Project > Download and Debug, or click the icon shown in Figure 36, then accept the J-Link pop-up

dialog in order to use the flash breakpoints (as shown in Figure 37).

File Edit View Project J-Link Tools
NOE@ = X DcC

Window Help

+ <3 >%8+=2<Q0 >0 RO -= »

Figure 36. Start/Stop Debug Session Icon

ah
z
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H J-Link V6.34h Out of breakpoints 23

The debuggeris trying to set a breakpaoint in flash memary at address 0x001003E8
I L The target CPU has run out of hardware breakpoints

In order to setthe requested breakpaint a software breakpaint in flash memary can be set

Unlimited breakpoints inflash memory (Flash Breakpoints) is an enhanced feature of J-Link which requires an additional license.

Some members of the J-Link family (such as J-Link PRO and J-Link PLUS) already come with a built-in license for unlimited breakpoints in flash memory.
In order to buy a license for unlimited breakpaints in flash memaory for the connected emulator, please getin touch with salesi@segger.com
Far mare information reqarding this feature, please refer to hitp:/ fwww. segger.com/fjlink_buy_flashbps himl

Howewver, using this feature without the additional license is possible and permitted if used for evaluation only,
Ewaluate unlimited breakpoints in flash memory now 7

J-Link 2/MN: 483035875

Do not show this message again fi

| ves || Mo H Install existing license...

Figure 37. J-link “Out of breakpoints” pop-up dialog

If you are having trouble downloading firmware because an application with Sleep Mode is on the Evaluation
and Development Board, see Section 6.4.1, “Downloading Firmware in Sleep Mode” on page 40.

3. The application runs up to the first breakpoint in main. You can press F5 or the Run icon (as shown in
Figure 38) multiple times to step through the code and observe that the LED changes its state when the

application executes the function Sys_GPIO Toggle (LED _DIO). To stop the debug session, press the Stop
icon.
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@ work - AR Embedded Workbench IDE - Arm 832.1 a]E@®]
File Edit View Project Debug Disassembly J-Link Tools Window Help
DOR@ = LE0 DC » ¢ Q> 8=¢ 85[0 ..-EGC@=301P'i*iO@ﬂ ciEman o
Workspace v 32X “ app.c X ‘ v! Disassembly v 31X
|Debug i }main(] r(_) Gota | Mematy
105 \_ # Assumptions  : Nome -

Files L L ) 106 L ¢ & || Disassembly

B @ blinky - Debug < 107  int main{void) !

1 W CMSIS-Pack 108 H { main:
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5[10_protocal.o 3 12 /¢ Initaalize the systam */ 0z1003ec: 0x2001 MOVE
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114
SHD,sysiasrc..c ne + spin laop #/ Initialize():
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sI10_sys_clock = { Sys_Watchdoy Refresh();
310 sys_cree = 118 /% Refresh the vatchdog timer +/ 0z1003f4: D=xf7ff Oxffb5 BL
510_sys_dmac 119 Sys_Watchdag Refresh(); if (led_togyle status == 1)
sl10_sys_flash.c 120 0x1003£8: 07820 LDRB
310_sys_powe.. 121 /* Toggle GBIO 6 (if toggling is enabled) then vait 0.5 seconds */ 0z1003fa: Dz2801 CMP
5(10_sys_powe... 122 if (led toggle status = 1) 0z1003fe: 0=4003 BEQ.N
s10_sys_rife.c 123 i Sys_GPI0_Set Low(LED_DIO):
3110 gys_timer, R Sya_GPIO Toggle (LED DIO)3 0x1003fe: 0x2006 MOvS
3l10_sys_uartc 125 1 0x100400: Dzf7ff 0xf£95 BL
510_sys _versi 126 else 0xz100404: 0z=002 B.N
F2 Minclude 127(] f 1l Sys_GPI0_Toggle(LED_DIO):
L Regph EZ ] Sys_GPIO_Set_Low(LED DIO); ‘ | .
q e
raep;jd;e,blinkym 52 | Sprleiny roatenRMM{ (a2 Cl8 "t SyspeatoreCioco) F UXlgnggelgéf;ggEﬁéﬁ;( tEEntSZ_t
Le & Oulput T | ! 0z10040c: Dz4B17 LDR.N
I I I == 0z10040=: DxhB00 LDR b
blinky o ‘ < 1 g |I 71l il | b
Debug Log vaX

Log &

Fri bay 17, 201913:29:42: ROMTRI[0[2]: E0002000, CID: B105E00D. PID: 002BB003 FFB

Fri May 17, 201913:28:42: Executing RSL10 reset type: 100000002

FriMay 17, 201913:23:42: Unsupponed RSL10 Reset Type: 0x00000002

FriMay 17, 201913:28:42: Hardware resetwith stratecy 2 was performec

FriMay 17, 201913:28:42: Initial resetwas performed

Fri May 17, 201913:20:43: J-Link: Flash download: Bank 0 @ 0:x00100000: 1 range affectsd (2048 bytes)

FriMay 17, 201913:28:43 H.ink: Flash dovnload: Total time needsc: 0.214s (Prepare: 00853, Compare: 0.022s, Erase: 0.024s, Program: 0.045s, Verify: 0.020s, Restore: 0.0075)

FriMay 17, 201913:29:43 1860 bytes downloaded and verified (4.01 Khytes/sec)

FriMay 17, 201913:23:43: Loaded debuges: C:\New falderiblinky\ DebughExe'blinky.out 3

FriMay 17, 201913:28:43: Executing RSL10 reset type: 1x00000001 i

FriMay 17, 201913:28:43 Software resetwas performed

FriMay 17, 201913:29:43; Target reset =

Cuibde .17 901N 13.90-C0O. O 1. kit Moo S e 219419 b e kol

4 111 3

Uild | Debug Log ‘

Ready

Figure 38. Debug Session in the IAR Embedded Workbench
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CHAPTER 6

Advanced Debugging

6.1 PRINTF DEBUG CAPABILITIES

The PRINTF () macro is used to provide printf () debug capability in RSL10 applications. The implementation
of the PRINTF () macro is user selectable to allow for different types of debug interfaces. The functionality is accessed
via the tracing API.

The tracing API supports two debug interfaces: UART and RTT. The implementation of the tracing functions can
be found in the app_trace.c file. The developer can select the debug interface during the compilation process by setting
the RSL10_DEBUG macro in the app_trace.h file. If the macro is set to DBG_NO, tracing is disabled. This is the default
behavior in all sample applications.

NOTE: The files app_trace.c and app_trace.h need to be present in your sample application, and
initialized using TRACE_INIT (), in order to for you use the PRINTF () feature. You can find
these two required files in most Bluetooth Low Energy sample applications, such as
ble_peripheral_server_bond.

To debug time critical applications, we recommend setting the tracing option to DBG_RTT option. With SEGGER
RTT (Real Time Transfer), you can output information from the target MCU to the RTT Viewer application at a very
high speed without compromising the target’s real time behavior. More information about SEGGER RTT can be found
in JLINK user manual, at www.segger.com.

6.1.1 Adding Printf Debug Capabilities

To add printf debug capabilities over UART, change the define in the app_trace.h file to #define RSL10 DEBUG
DBG_UART, and set the RSL10_DEBUG macro to DBG_UART. A standard terminal program on a PC can be used to view
the debug output.

To add RTT printf debug capabilities, change the define in the app_trace.h file to #define RSL10_ DEBUG
DBG_RTT and add the SEGGER RTT files to the application. The Segger RTT Viewer application on a PC can be used
to view the debug output.

Samples for RTT are under C:\Program Files (x86)\SEGGER\JLink_V640b\Samples\RTT.

More information about the RTT API can be found in the JLINK manual, under C:\Program Files
(x86)\SEGGER\JLink_V640b\Doc\Manuals.

NOTE: Note that these RTT sample and information files are for SEGGER JLink version 640b.

6.2 DEBUGGING APPLICATIONS THAT DO NOT START AT THE BASE ADDRESS OF FLASH

If you want to debug an application that does not start at the first address of the flash memory (0x00100000), read
on. For example, you might be debugging an application in RAM, or a flash memory application that has been placed in
a different address.

This procedure assumes you have performed the steps in Section 3.3.1, “Debugging with the .elf File” on page 13,
and you are using the ON Semiconductor IDE:

1. In your Debug configuration, change to the Startup tab
2. Enter the following in the Run/Restart Commands field as illustrated in Figure 39:
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set {int} & VTOR = ISR Vector Table
set $sp = *((int *) &ISR Vector Table)

[l Main %5 Debugger | & Startup . %~ Source|[] Common
Initialization Commands
Initial Reset and Halt Type: Low speed: 1000 kHz
JTAG/SWD Speed: @ Auto () Adaptive (O) Fixed kHz
Enable flash breakpoints
Enable semihosting Console routed to: [#] Telnet [| GDB client
Enable SWO CPU freq: 10000000 Hz. SWO freq: 0 Hz. Port mask: Ox1

Load Symbols and Executable
Load symbols
(@) Use project binary: blinky.elf
(C) Use file: Workspace... File System...
Symbols offset (hex):
Load executable
@) Use project binary:  blinky.elf

111

") Use file: Workspace... File System...
Executable offset (hex):

Runtime Options

"] RAM application (reload after each reset/restart)

Run/Restart Commands

Pre-run/Restart reset Type: (always executed at Restart)

set {int} &_VTOR = ISR_Vector_Table <
set $sp = *((int *) &ISR_Vector_Table)

D Set program counter at (hex):
Set breakpoint at; main
Continue

Figure 39. Setting Up a GDB Launch Configuration, Startup Tab

6.3 Arm Cortex-M3 Core Breakpoints

A maximum of two hardware breakpoints can be set at a given time. If you need more than two breakpoints, you
can use the Unlimited Flash Breakpoints feature available through J-Link.

IMPORTANT: You can use hardware breakpoints when using the debugger with the Arm Cortex-M3 core, but
software breakpoints cannot be used with the flash overlay. Writing to flash memory does not place breakpoints
within the overlay, so any attempt to use software breakpoints would be ineffective.

6.4 DEBUGGING WITH Low POWER SLEEP MODE

Debugging applications that use sleep mode is a challenging task because the hardware debug logic and system
clocks are powered down when the device goes to sleep. Therefore, the debug session cannot be kept alive between
sleep cycles.
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Besides using GPIOs, UART, and other peripherals as tools to help debug your application, you can reattach the
debugger after the device wakes up from sleep. To do so, you need to make sure that the device stays awake, and start a
new debug session to connect to the running target, making sure a reset is not performed. The following instructions
show an example of how to perform this on the peripheral_server_sleep sample application in the ON Semiconductor
IDE, but you can also adapt it for other applications that use sleep mode, and for other IDEs.

1. Copy the peripheral_server_sleep application into your workspace and navigate to the app_process.c source
file under the code folder.

2.  Modify the function void Continue Application (void) by adding a while loop before the
Main Loop () ; call, to make sure that the device stays awake in the infinite loop after waking up (see
Figure 40). Save and compile your application.

o eclipse-works

Fite Edit

i v ® WrElrEr@r -0~ Qe ™ ¢~ 45 - v -

B €T+ Projects i app,_processc = Outline
LA L\ ws_aa_manu

= b pevipheral_servt_siesn " SY¥S_WAIT_FOR_INTERRUPT;
& Ginanes
& Includes. FIOCE L8 ¥

enable_irg();

disable_irq();

1

if (RTC_CLK_SRC |= RTC_CLK_SRC_XTAL3I2K)

4 { *° appm_default_state

il ble nide 17 #iF (LOW_POWER_CLK_UPDATE == LOW_POWER_CLK_UPDATE_ENABLE} .t % handier
il cakbrationc a Enable_Audiosink Messuresent();
i wakeup_smS i Bendif
il weaipet.c A ¥
Debug . s Rt ai

s incluce .

g enable_irq();

& appc o forcing basshand wak

& periphersl_server_sieep rieconfig BEIF->(TAL = BB_CLK_ENABLE | BBCLK_DIVIDER VALUE | BB_DEEP_SLEEP;
reacme_pesipheral _server_sieep.nd

sectians Jightid o

sections i

| Sys_Watchdog Refresh();
}

Main_Loop();

Figure 40. Continue_Application Function Perspective After Adding While Loop

3. Within the Project Explorer, right-click on the .elf file and select Debug As > Debug Configurations.
4.  When the Debug Configurations dialog appears, create two debug sessions:
a. Debug session that initiates restart and halts the target:
i.  Right-click on GDB SEGGER J-Link Debugging and select New. A new configuration appears
under the GDB SEGGER heading, with new configuration details in the right panel.
ii. Adjust the displayed values for your configuration and click on Apply (see Figure 41 and Figure 42
on page 35).

NOTE: If you are having trouble downloading firmware to the device, in addition to using DIO12, you
can also perform the software recovery by setting the Reset Type to 1 in the Debug session
configuration (see Figure 41). The default Reset Type is 0, which only resets the Arm Cortex-M3
core while leaving the device/peripherals in a state where J-Link can't reconnect. Setting the
Reset Type to 1 ensures that not only is the Arm Cortex-M3 core reset, but so are all the
peripherals. If this does not work, see Section 6.4.1, “Downloading Firmware in Sleep Mode” on
page 40.
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@ Debug Configurations
i Create, and run fig i
) X

type filter taxt
CfC++ Application
C/C++ Attach to Application
[E] C/C++ Postmortem Debugger
[E] €/C++ Remate Application
@ Eclipse Application
[€1 GDB Hardware Debugging
[E] GDE CpenQCD Debugging
+ [£] GDB SEGGER J-Link Debugging
[£] peripheral_server_sleap Debug
[E] peripheral_server_sleep_swd_att
BT Java Applet
[T Java Apglication
Ju JUnat
J MUnit Plug-in Test
& Launch Group
¥ Launch Group (Deprecated)
Bl Mwel Launch
& D56 Framework
T, Remate Java Application

Fitter matched 19 of 100 items

@

Name: peripheral_server,

sleep Debug

[ Main| % Debugger [ M' % Source| T Common 7. SVD Path
Initialization Commands

Viinitial Resetand Halt[Type: 1T | Lowspeed: 1000 Kbz

ITAG/SWD Speed: @ A

ute () Adaptive () Foed kHz

+| Enable flash breakpaints

+| Enable semihosting

| Enable SWO CPU freq: 0

Consale routed to: /| Teinet || GDB client
Hz. SWO freq: 0

Load Symbols and Executable

| Load symbaols
9 Use project binary:
Use file:
Symbeols offset (hex):
| Load executable
@) Use project binary:
Use file:

peripheral_server_sieep.elf

peripheral_server_sleep.elf

Executable offset (hex):

Hz Portmask Oxl

Figure 41. Setting Reset Type in the Debug Configuration Session
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Figure 42. Startup Tab:
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#
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b. Debug session that connects to the running target:
i.  Create another new debug configuration under the GDB SEGGER heading, with new configuration
details in the right panel.
ii.  Adjust the displayed values for your configuration then click on Apply (see Figure 43 and Figure 44
on page 37).

D ————_—

ﬁ.

[
Create. manage. and run configurations

Mame: peripheral_server_sieep Debug_swd_att

A Main| ® Debugger - # Startup| % Source. T Common| 7, SVD Path

E1C/C++ Appiication J-Linik GDB Servér Setug
e AT D Abpiotr 7 Start e J-Link GOB server locally
[ €/C+ + Postmartem Debugger
D /s + Remote Apcbiention Executable pathe  ${/link_pathi/$|jlink_gdbssrver] |Browse.. | | Variables..|
© Eclipse Appication CProgram il 1
: f:: -mam—: I;:Imwmq [xo change it use the glotal o wotkspace prel
) GOB OpenOCD Debiugging ; -
+ 7] GDE SEGGER J-Link Debugging m e
T pevipheral_server_sieep Debug Endianness ) Little Big
7] peripheral_server_sieep Debug (1) Comnettion duss O (USE serinl o IP name/address)
1 Java Appiet Interface @ WD ITAG
: ::""“D eaon Initial speet: Ao ) Adapti O Fined 1000 kHz
nit
R JUnit Phug-in Test 608 porc B3R
[ | A Launch Group SWO port: nn o Verily downloads | Initalize registes
|| ™ Launch Gioup Meprecatad) Teinet port: 13 7 Lacal bast only Sitent
K Mwed Launch
& O5Gi Framewesk Log tile Browse.
& Rermote Java Application Oeher options: singlerun -strict -timeout 0 -nogus
Aliocate ¢ the GO ¥ Allocate console for semihosting and SWO
GDA Client Sewg

Exscutabile name: Beovese.

Variabies

$icross prefinigdbSicross udfix)
Actual executables arm-nang-eati-goo
Other options:

Commands: 561 mem inacoessibie-by-defauts off

Remate Target
Host name o 17 address:  localhost

Port number:

Force thiead list update on suspend

Fifter matched 19 of 107 dens Apply
) | Detug | Cose |

Figure 43. Debugger Tab: Debug Session that Connects to the Running Target
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@ Debug Configuraticns

Create, and run

X EZ~r
type filter text
1 C/C++ Application
1 C/C++ Attach to Application
] C/C+ + Postmortem Debugger
1 C/C++ Remate Application
© Eclipse Application
] GDB Hardware Debugging
] GDB OpenQCD Debugging
| GDB SEGGER J-Link Debugging
[E] peripheral_server_sleep Debug
] peripheral_server_sleep_swd_att
1 Java Applet
T Java Application
Ju it
3t JUnit Plug-in Test
% Launch Group
¥ Launch Group (Deprecated)
15 Mwe2 Launch
& 08GI Framework
L Remote Java Application

Filter matched 19 of 100 items

Mame: peripheral_server_sleep Debug

[ Main | # Debugger | B Startup . %~ Source| T Common | %, SVD Path

Intialization Commands

7| Initial Resetand Halt|Type: 1 |Lowspeed: 1000 kHz
ITAG/SWD Speed: @ Auto Adaptive Fiwed kHz

| Enable flash breakpoints
+| Enable semihosting Console routed to: |+ Telnet || GDB client
| Enable SWO CPU freq: 0 Hz. SWO freq: 0 Hz. Port mask: Oxl

Load Symbaols and Executable
| Lead symbols
@ Llse project hinary: peripheral_server_sleep.elf

Use file:

Symbals offeet (hex):

| Load executable

@ Use project binary:  peripheral_server_sleep.elf
Use file:

Executable offset (hex):

ON Semiconductor

b

Revert

Apply

Debug

Close

Figure 44. Startup Tab: Debug Session that Connects to the Running Target

NOTE: If you are having trouble connecting to the running target, you can perform a software recovery
by setting the Reset Type to 1 in the Debug session configuration as shown in Figure 44. The
default Reset type is set to 0, which only resets the Arm Cortex-M3 core and leaves the device/
peripherals in a state where the J-Link cannot reconnect. By setting it to 1, you ensure that not
only the Arm Cortex-M3 core is reset, but also all the peripherals. If this does not work, see
Section 6.4.1, “Downloading Firmware in Sleep Mode” on page 40 for more ideas.

5. Start the first debug session (which initiates target restart). Once the target is halted at main, resume the
execution (see Figure 45).
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File Edit |Source Refactor Mavigate Search Project Run Window Help
i .«'@-fﬂ'@ YN IP L L Y I T

4% Debug 2
4 [F] peripheral_server_sleep Debug [GDB SEGGER J-Link Debugging]
- penpheral_senver_sleepaelf

nain() at app.c2l Onl01%e4

Wi JUnkGDRServerl Lexe
«i arm-none-eabi-gdb
Wi Semihosting and SWV

l¢ appc &

13 ™ $Revision: 1.72 §

19=int main()

# 21 App_Initialize();

22
23 /* Wait for 3 seconds to allow re-flashing directly after pressing RESET */
24 Svs Delav ProgramROM(3 ® SvstemCore(lock):

Figure 45. First Debug Session Perspective Before Starting Execution

6. Wait until the target enters Deep Sleep Mode. At this point the debug connection is lost; and even when the
target is awake, it cannot establish a connection with JTAG. The following output is generated on the console
(see Figure 46).
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& Console &2 Tasks Problems Executables B Debugger Console iile
peripheral_server sleep Debug [GDB SEGGER J-Link Debugging] JLinkGDBServerCL.exe
ERROR: Can not read register 2 (R2) while CPU is running

ERROR: Can not read register 3 (R3) while CPU is running

ERROR: Can not read register 4 (R4) while CPU is running

ERROR: Can not read register 5 (R5) while CPU is running

ERROR: Can not read register 6 (R6) while CPU is running

ERROR: Can not read register 7 (R7) while CPU is running

ERROR: Can not read register 8 (R8) while CPU is running

ERROR: Can not read register 9 (R9) while CPU is running

ERROR: Can not read register 10 (R10@) while CPU is running
ERROR: Can not read register 11 (R11) while CPU is running
ERROR: Can not read register 12 (R12) while CPU is running
ERROR: Can not read register 13 (R13) while CPU is running
ERROR: Can not read register 14 (R14) while CPU is running
ERROR: Can not read register 15 (R15) while CPU is running
ERROR: Can not read register 16 (XPSR) while CPU is running
ERROR: Can not read register 17 (MSP) while CPU is running
ERROR: Can not read register 18 (PSP) while CPU is running
ERROR: Can not read register 24 (PRIMASK) while CPU is running
ERROR: Can not read register 25 (BASEPRI) while CPU is running
ERROR: Can not read register 26 (FAULTMASK) while CPU is running
ERROR: Can not read register 27 (CONTROL) while CPU is running
WARNING: Failed to read memory @ address @xDEADBEEE

Starting target CPU...

ERROR: CPU is not halted

ERROR: Can not read register 15 (R15) while CPU is running
Reading all registers

4

Figure 46. Debug Session Perspective when Debug Connection is Lost

7. Stop the debug session and click on the Terminate icon to remove all terminated targets (see Figure 47).

25 )
o < - . = 1 | »
& Console &2 Tasks Problems Executables & Debugger Console Memao
[ | B
peripheral_server_sleep Debug [.GDB SEGGER J-Link Det.nugging] _IL.inkGDBSz?r\.ferCL.exe [Terml’nate ]
ERROR: Can not read register 15 (R15) while CPU is running

Figure 47. Terminate Targets Icon

8. After the target exits Deep Sleep Mode, it is running in the infinite loop (step 1), and we can connect to the
running target by starting the second debug session (see Figure 48). Note that the debugger is able to reattach
to the running target and halt the processor after waking up from sleep.
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T — . .
- SR R N O L &l I B il ¥ - iy ick Access || 2| G
& Debug e = -| # Expressions 11 Bele x%ir-
« [7] pevipheral_server_sieen_swd_att [GDB SEGGER J-Link Debuggng) Exprettion Type Vatoe

a i¥ penipheral_server_sieep.ell - _stack <1ext variable, no debug infas {<text variable, no debug mfo=] (x20005eB

+ 4 Thiead #1 57005 (Suspsndie : Sigrsd : SIGINTIntesrunt) & Add new expression
[E Comtinue_Applicationt a1 app.processc3ot Ox10054
= Wakeup_Fram _Seep_Application]) a1 app_peocess c281 02000006
B (ufifitite

o Lk GDEServerCLexe

4 arm-nang-eats-gan

o semihesting snd SWY

£ 3PP POCERRC 25 Dutline FPEARY e ®
19 u spph
z baseband wake-up * *" foop_ont

BIIF-3CTRL = BE_CLK_ENABLE | BBCLK_OIVIDER_VALUE | BB_DEER_SLEER;

while(1}

:

MAX_BUF_CNT
measure_buf
dynamic_measurement_ wait
out ent

Main app uarn_vialiel_bil_enil
Hain_Loop(); TASK_DESC APP
a0pm_cefault_state

* appm_default_handier
appm_state
Shoep Mode ¢

TR

igarn{siruct sieen. mace_env_tag"
A " a)

Figure 48. Second Debug Session Perspective After Connecting to the Running Target

6.4.1 Downloading Firmware in Sleep Mode

If an application with Sleep Mode is currently on your board, and changing the Reset Type to 1 as described in
Section 6.4, “Debugging with Low Power Sleep Mode” is not working, try the following:

1. Connect DIO12 to ground.

2. Press the RESET button (this restarts the application, which pauses at the start of its initialization routine).

3. Repeat step 2 above. After successfully downloading blinky to flash memory, disconnect DIO12 from ground,
and press the RESET button so that the application works properly.

Alternatively, use the Stand-Alone Flash Loader (available with its own manual in the RSL10_Utility_Apps.zip file)
to erase the application with Sleep Mode from the board’s flash memory.
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CHAPTER 7

More Information

7.1 FOLDER STRUCTURE OF THE RSL10 CMSIS-PACK INSTALLATION

By default, your files are installed in the following location:

+ Ifyou are using the Eclipse-based ON Semiconductor IDE: C:\Users\cuser id>\ON_Semiconductor\PACK.

+ Ifyou are using the Keil IDE: C:\Keil_v5\ARM\PACK
» Ifyou are using the IAR IDE: C:\Users\<user_name>\IAR-CMSIS-Packs

Subfolders are described in Table 1, below, and Table 2 on page 41.

Table 1. Installed Folders - CMSIS-Pack

Folder Contents

configuration J-Link flash loader files.

documentation Hardware, firmware and software documentation in PDF format. Also 3rd-party
documentation from other companies besides ON Semiconductor. Available from the books
tab in the IDE.

images Contains evaluation board pictures.

include Include files for the firmware components and libraries. Projects can point to this directory
and sub-directories when including firmware header files.

lib Pre-built libraries which can be linked to by sample code or other source code. Project
linker settings must point to this directory when linking with firmware libraries.

source firmware The source of the provided support libraries.
samples/rsix (for ON Semiconductor IDE) | Sample code sources as ready-to-build
samples/uv (for Keil IDE) projects.
samplesf/iar (for IAR IDE)

svd Contains the System View Description file used in the registers view during debugging.

Table 2. Installed Folders - ON Semiconductor IDE

Folder Contents

arm_tools The Arm Toolchain is installed here.

eclipse Pre-built libraries which can be linked to by sample code or other source code. Project
linker settings must point to this directory when linking with firmware libraries.

jre* The included JAVA runtime environment.

ON Semiconductor IDE

ON Semiconductor license agreement, revision file and pack description file.

7.2 DOCUMENTATION

7.2.1 Documentation Included with the CMSIS-Pack

A set of documents is included with the CMSIS-Pack installation in

C:\Users\cuser id>\ON_Semiconductor\PACK\ONSemiconductor\RSL10\<pack_version>\documentation (where

<user_id is your profile name, and <pack_version> is the version number, e.g., 3.0.521).

These documents are also accessible via any of the three IDEs:
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*  ON Semiconductor IDE: documentation is accessible through the C/C++ perspective by opening any RTE
configuration file, such as blinky.rteconfig, and selecting the tab Device (see Figure 49 on page 42).

«  Keil pVision IDE: documentation is available in the Books tab, as shown in Figure 50 on page 43.

* IAR Embedded Workbench: documentation is accessible through the IAR Embedded Workbench CMSIS

Manager window, as shown in Figure 51 on page 44.

| DT R B———— |
File Edit Source Refaclor Navigate Search Project Run Window Help
w5 O-R - R -E -G~ 0 -~ %~ DO 7~ i@ -iBQiw e mn oo
Iy Project Explorer & BERl® 7T 0 |[dstartc | @ blinkyrtecontig & |[E100 & mainc - a
4 &5 blinky B Device @
& Binaries
W Includes Device:  RSL10
+ (= Debug Family: RSL10 Series CPU: ARM Cortex-M3
t blinky.elf - [arm/le] SubFamily: s S
i maino - [armyle] Vendor:  ONsemiconductor Memory: 32 kB RAM, 384 kB ROM
:::g:':; Pack  ONSemiconductorRSL10.120 FRU: (312
maind URL: bt/ Aevew kil com/dd iconductor/rsl10 Endian: Little-endian
i makefile _D!""Oe data books: ) Description:
» objectsmk W ARM and Thumb-2 Instruction Set Quick Reference Card RSL10 is an ultra-low-power, multi-protocol 24 =
» sources.mk Specification GHz radio designed for use in wireless devices
subdir.mk face Specification i f:lcmar?d e e
. restricted size.
B RTE 2C Interface Specification
[& mainc @®RS5L10 Firmware Reference
# blinky.rteconfig @ RSLI0 ¢ are Reference
readme_blinky.ba @ RSL10 Sample Code User's Guide
sectionsid AW BLE Alert Notification Profile Interface Specification
& RW BLE Battery Service Interface Specification
AW BLEB essure Profile (8 terface Specification

@RW BLE
@RW BLE Cy

@ RW BLE Device Information Senvice Interface Specification

Power Profile Interface Specification

ng Speed and Cadence Profile Interface Specification

@ RW BLE Find Me Profile Interface Sp
&AW BLE Glucoss Profile (GLP) Interface
@RW BLE Health Thermem
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Profile Interface Specification

@AW BLE Heart
@ RW BLE HID Over GATT Profil
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@ RW BLE Location and Navigation Profile Interface S
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@AW BLE Phone Alert Status Profile Interface Spec
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Components | Device Packs

Figure 49. Accessing RSL10 Documentation from the ON Semiconductor IDE
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File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

‘lelﬂﬂ| I ﬂ|"7 “' .Eff_fff=||a co_rand
|§‘Iﬂ B2y | l‘"“ Target 1 @
Books 2B
=il Device Data Books -

-8 RSL10 Firmware Reference

@ RSL10 Hardware Reference
-4 RSL10 Sample Code User's Guide
@ Getting Started with RSL10
& ARM and Thumb-2 Instruction Set Quick Reference Card

@ Gap Interface Specification
@ GATT Interface Specification
-8 | 2C Interface Specification

@ RW BLE Alert Natification Profile Interface Specification
-4 RW BLE Battery Service Interface Specification
- RW BLE Blood Pressure Profile (BLP) Interface Specification
- RW BLE Cycling Power Profile Interface Specification

@ RW BLE Cycling Speed and Cadence Profile Interface Specification
- RW BLE Device Information Service Interface Specification
~&® RW BLE Find Me Profile Interface Specification
.- RW BLE Glucose Profile (GLP) Interface Specification

@ RW BLE HID Over GATT Profile Interface Specification
- RW BLE Heart Rate Profile (HRP) Interface Specification
- RW BLE Health Thermometer Profile Interface Specification

@ RW BLE Host Error Code Interface Specification
-4 RW BLE Location and Navigation Profile Interface Specification
- RW BLE Phone Alert Status Profile Interface Specification Interface Specification
& RW BLE Proximity Profile Interface Specification

& RW BLE Running Speed and Cadence Profile Interface Specification
- RW BLE Scan Parameters Profile Interface Specification
-8 RW BLE Time Profile (TIP) Interface Specification

@ RW BLE Wireless Power Transfer Profile (WPTP) Specification
=il Board Data Books

"4 RSL10 Evaluation and Development Board Manual (RSL10 Evaluation Board)

T

il Project (@Bouks fr {1 Functions []+TE'“|F|&'_EE

Figure 50. Accessing RSL10 Documentation from the Keil uVision IDE
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Figure 51. Accessing RSL10 documentation from the IAR Embedded Workbench
For more information, see the following:

Arm and Thumb®-2 Instruction Set Quick Reference Card

From the Arm company, this quick reference card provides a short-hand list of instructions for
the Arm Cortex-M3 processor.

RSL10 Evaluation and Development Board Manual

This document actually contains a link to the manual that is stored elsewhere on the website. It
is a reference manual that provides detailed information on the configuration and use of the
RSL10 Evaluation and Development Board. When you use this board with the software

development tools, you can test and measure the performance and capabilities of the RSL10
radio SoC.

RSL10 Firmware Reference

The system firmware provides functionality that isolates you from the hardware, and
implements complex but common tasks, making it easier to support and maintain your code.
The Bluetooth firmware provides an implementation of the Bluetooth host, controller, and
profiles, supporting the standards-compliant use of these components within your application.
This manual provides a reference to both sets of firmware features, and explains how they can
assist with the development of your applications.
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RSL10 Hardware Reference
Describes all the functional features provided by the RSL10 SoC, including how these features
are configured and how they can be used. This manual is a good place to start when you are
designing real-time implementations of your algorithms. or planning a product based on the
RSL10 SoC.

RSL10 Sample Code User’s Guide
Explains how to use the sample applications provided with the RSL10 software development
tools. You learn about setting up your system, accessing code files, and how the sample
applications work, using the Peripheral Device with Server sample code as the prime example.

RivieraWaves Interface Specifications (files in the ceva folder)
Interface Specifications from RivieraWaves provide a description of the API for the specified
library:

* GAP Interface Specification

* GATT Interface Specification

* Host Error Code Interface Specification

* L2C Interface Specification

* RW BLE Alert Notification Profile Interface Specification

* RW BLE Battery Service Interface Specification

* RW BLE Blood Pressure Profile (BLP) Interface Specification

* RW BLE Cycling Power Profile Interface Specification

* RW BLE Cycling Speed and Cadence Profile Interface Specification
* RW BLE Device Information Service Interface Specification

* RW BLE Find Me Profile Interface Specification

* RW BLE Glucose Profile (GLP) Interface Specification

* RW BLE HID Over GATT Profile Interface Specification

* RW BLE Heart Rate Profile (HRP) Interface Specification

* RW BLE Health Thermometer Profile Interface Specification

* RW BLE Location and Navigation Profile Interface Specification

* RW BLE Phone Alert Status Profile Interface Specification

* RW BLE Proximity Profile Interface Specification

* RW BLE Running Speed and Cadence Profile Interface Specification
* RW BLE Scan Parameters Profile Interface Specification

* RW BLE Time Profile (TIP) Interface Specification

* RW BLE Wireless Power Transfer System Profile Interface Specification

LPDSP32 Documentation
The following documents are available in the RSL10_LPDSP32_Support.zip file:

» RSL10 Getting Started with the LPDSP32 Processor, which provides an overview of the
techniques involved when writing and integrating code for the LPDSP32 processor that is on
RSL10.

* LPDSP32-V3 Block Diagram, which provides a drawing of all the inputs, outputs,
components and process blocks

* LPDSP32-V3 Hardware Reference Manual, which describes the hardware aspects of the
LPDSP32-V3 core and its operations to provide an understanding of the core architecture and
various kinds of supported operations.

* LPDSP32-V3 Interrupt Support Manual, which describes how interrupts are supported.
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» User Guide IP Programmers for LPDSP32-V3, which describes the C application layer, the
flow generally followed when any application is ported to LPDSP32, various tips for
optimization to make the best use of the processor and compiler resources, and certain things
the programmers should be aware of when porting applications. It also provides a few
examples to show the usage of LPDSP32 intrinsic functions and to give an idea of how
certain DSP functions can be ported to and optimized for LPDSP32.

RSL10 Release Notes
Lists new features in the latest release and known issues. This file is downloaded with the
installer in a zip file, and is not in the documentation folder.

7.2.2 Documentation in the documentation.zip File

You can access documentation through the documentation.zip file available with this release of RSL10. It contains
all of the documents included with the CMSIS-Pack as well as the following:

Getting Started with RSL10 Bluetooth Low Energy Mesh
Helps you to get started with the RSL10 mesh package. It guides you through the process of
installing the mesh package alongside the RSL10 SDK, configuring your environment, and
building and debugging your first RSL10 mesh network.

RSL10 Bluetooth Low Energy Mesh Sample Code User’s Guide
Shows you what the mesh sample application (ble_mesh) demonstrates, how to configure the
project to set up different mesh network scenarios, and how to experiment with them to verify
their features and operations.

Files in the mindtree folder (related to Bluetooth Low Energy Mesh networking)
« EtherMind_Mesh_APIl.chm
» EtherMind_Mesh_Application_Developer's_Guide_Generic.pdf
» EtherMind_Mesh_CLI_User_Guide.pdf

RSL10 Bootloader Guide
The RSL10 bootloader provides means of performing firmware updates using the UART
interface, and is a required component for Firmware Over the Air (FOTA). The bootloader
enables firmware updates without the use of the JTAG interface. Firmware can be loaded from a
host microcontroller over UART or over the air from another wireless device using FOTA. The
bootloader copies the firmware image to the designated location in flash memory. This
document describes the bootloader firmware application and development tools.

RSL10 Firmware Over-The-Air User’s Guide
This manual describes Firmware Over-The-Air (FOTA) with RSL10. It provides the
prerequisites and instructions necessary to develop FOTA-ready firmware applications and to
perform FOTA updates in the field.

RSL10 LPDSP32 Support Manual
Provides an overview of the techniques involved when writing and integrating code for the
LPDSP32 processor included with the RSL10 radio System-on-Chip (SoC).

RSL10 Getting Started with the LPDSP32 Processor
Provides an overview of the techniques involved when writing and integrating code for the
LPDSP32 processor that is on RSL10.
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Manuals in the Ipdsp32 folder:

» LPDSP32-V3 Block Diagram: provides a drawing of all the inputs, outputs, components and
process blocks

» LPDSP32-V3 Hardware Reference Manual: Describes the hardware aspects of the
LPDSP32-V3 core and its operations to provide an understanding of the core architecture and
various kinds of supported operations

» LPDSP32-V3 Interrupt Support Manual: Describes how interrupts are supported

» User Guide IP Programmers for LPDSP32-V3: Describes the C application layer, the flow
generally followed when any application is ported to LPDSP32, various tips for optimization
to make the best use of the processor and compiler resources, and certain things the
programmers should be aware of when porting applications. It also provides a few examples
to show the usage of LPDSP32 intrinsic functions and to give an idea of how certain DSP
functions can be ported to and optimized for LPDSP32.

RSL10 Stand Alone Flash Loader Manual
Provides the information that you need to use the stand-alone flash loader. It describes the
operations that the flash loader can perform, and explains how to configure the flash loader to
connect to an RSL10 radio IC. The stand-alone flash loader is used to program, erase and read
flash memory in RSL10.

RSL10 Release Notes History
A zip file containing the release notes for previous releases.
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Migrating to CMSIS-Pack

If you have an existing project and have not used the RSL10 CMSIS-Pack before, this section is for you. Starting
from SDK 3.0, the RSL10 firmware is no longer bundled with the Eclipse IDE. The RSL10 Eclipse IDE has been
optimized and rebranded as the ON Semiconductor IDE, and the RSL10-specific firmware is now delivered exclusively
as a separate CMSIS-Pack that can be imported into the IDE. For future RSL10 releases, you only need to download
and import the updated CMSIS-Pack. There is no need to re-install the Eclipse IDE if it has not been updated.

Existing Eclipse project files from previous SDK releases are not compatible with the new ON Semiconductor
IDE. Fortunately, migrating your existing project into the new IDE to take advantage of the CMSIS-Pack standard is a
straightforward process, as shown in the next section.

A.1 MIGRATING AN EXISTING ECLIPSE PROJECT TO THE CMSIS-PACK METHOD

In order to tell whether your project is managed by CMSIS-Packs, check that a file with the .rteconfig extension is
present in the project folder. If not, your project is not managed by CMSIS-Packs and needs to be migrated. The easiest
way to migrate your existing Eclipse project to the new IDE is to start from one of the CMSIS-Pack RSL10 sample
projects, and follow these steps:

NOTE: This section assumes you know how to import the CMSIS-Pack and a sample application, as
shown in Chapter 3, “Getting Started with the Eclipse-Based ON Semiconductor IDE” on
page 7.

1. Decide on which CMSIS-Pack sample project to import. It is best to import a CMSIS-Pack project that looks

similar (in terms of libraries used) to the existing project you would like to migrate. For example, if your

existing application uses the Heart Rate Profile, you might want to import the ble_peripheral_server_hrp
sample application as a reference.

Right-click the project and rename it as you wish.

Remove the source code from the sample project.

Copy over the source and header files from your existing project into the new one.

Open the RTE Configuration Wizard by double-clicking the .rteconfig file, and make sure all the software

components (libraries) required for your project are selected.

*  Pay special attention to the Bluetooth components, such as the Bluetooth Low Energy Stack, Kernel, and
Profiles. Ensure that these components have the correct variants selected (such as release, release_light, or
release_hci).

*  Some libraries might have been removed, such as the weakprf.a. This library has been replaced by the
stubprf.c file that is automatically added together with the Bluetooth Low Energy Stack component, so
you no longer need to explicitly reference it.

*  You can also remove (deselect) the software components that you do not need in your existing application.

» Ifyou change the .rteconfig file, make sure to save it, so that it can update your project settings
automatically (such as the library paths, includes, etc.) to reflect the newly added or removed software
components.

e wD

6. Navigate to your project settings and add or remove the preprocessor symbol or include folders from your
existing project.
7. Build your application and make sure it builds correctly.
* In case of build errors related to missing components, files, or preprocessor symbols, go back to steps 5
and 6 and review your configuration carefully.
» If you encounter errors related to duplicated code, review the RTE folder in your application. Some files
that were common to multiple sample applications have been transformed into software components, such
as the BLE Abstraction, CMSIS-Drivers, etc.
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*  For errors related to deprecated code or API changes, review the latest RSL10 CMSIS-Pack release notes
and check to see if there are any feature changes that could affect your project.

A.2 USING THE LATEST RSL10 FIRMWARE IN A PREVIOUS VERSION OF THE ECLIPSE-BASED IDE

We recommend always updating your installation to the latest version of the Eclipse-based ON Semiconductor
IDE. However, if your circumstances are such that this is impractical, you can manually update the RSL10 firmware
files in a previous version of the Eclipse-based IDE. If this is your case, try the following steps:

1. Download the RSL10 SDK CMSIS-Pack from www.onsemi.com/RSL10 and save it in any temporary folder.
Use a compressing tool, such as 7-Zip, and extract the contents of the ONSemiconductor.RSL10.version.pack
file.

3. Copy and replace the lib and include folders from the CMSIS-Pack into your existing RSL10 SDK Installation
folder.

4. Clean and build your application. If the build has been successful, you can see that it now references the
updated libraries and include files.

In case of build errors, make sure to review the latest release notes from the CMSIS-Pack and check to see if
there are any features or bug fixes that affect your application.
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APPENDIX B

Arm Toolchain Support

There are several ways in which the ON Semiconductor IDE determines which Arm GNU toolchain to use when
building. Understanding how this works can help prevent confusion and frustration, when the development machine has
several versions of GNU toolchains installed.

B.1 BASIC INSTALLATION

The ON Semiconductor IDE supports the Arm toolchain by installing it in the arm_tools directory within the
installed RSL10 software tools location. The build tools RM and Make are also included with the toolchain, to allow for
an easier building experience out of the box.

When the user starts the ON Semiconductor IDE with the IDE.exe program (whose shortcut is located in Windows
menu items), the arm_tools\bin directory is added to the path, to give the ON Semiconductor IDE access to the
toolchain installed with the RSL10 software tools.

Conflicts with toolchain versions can occur in the ON Semiconductor IDE, if an Arm-based toolchain has been
installed elsewhere or already exists on the path, and the IDE selects that toolchain rather than the one included in
arm_tools.

B.2 CONFIGURING THE ARM TOOLCHAIN IN THE ON SEMICONDUCTOR IDE

All toolchain location options can be accessed by right clicking on the project in the Project Explorer view,
selecting Properties at the bottom of the pop-up menu, and choosing the Toolchains tab. The scope of the toolchain
path support is described below.

Global Path: This is the path used by all workspaces/projects. The global path can be set in the Toolchains
tab of the project.

Workspace Path: This is the path used by all projects in the current workspace.

Project Path: This is the path used by the current project for its toolchain.

B.3 ADDITIONAL SETTINGS
Additional settings (other than the toolchain paths) are located within the MCU preference. These are:
*  The Build Tools path (global, workspace, project-based) for tools such as Make and RM

*  The Segger JLink path (global, workspace, project-based) for the location of the Segger JLink executables.
This replaces the Run/Debug string substitutions for JLink previously used.
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